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Executive Summary 

Program ROSTER (River-Ocean Survival and Transportation Effects Routine) 

jointly analyzes juvenile and adult PIT-tag detection data from migrating salmon and 

estimates a variety of performance measures related to salmonid migrations. Program 

ROSTER accounts for juvenile transportation, adult age structure, and known removals at 

detection sites, and provides maximum likelihood estimates and standard errors of juvenile 

inriver survival, ocean survival, adult inriver survival, smolt-to-adult ratios (SAR), 

transportation effects, and the adult age distribution. Several types of transportation 

effect measures are estimated, including dam-specific and systemwide measures, 

measures for untagged fish, and differential mortality (‘𝐷𝐷’). The user may also test for 

effects of juvenile transportation on the upriver adult migration. Program ROSTER is 

suitable for analyzing data from spring and summer Chinook salmon, sockeye salmon, and 

steelhead.
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1.0 Introduction 

This manual gives an overview of how to run Program ROSTER (Chapter 2), as 

well as background information on the statistical theory behind ROSTER (Chapter 3). 

Guidance on troubleshooting and fitting the model to difficult data sets is offered in Chapter 

4. The format of the model file is described in Chapter 5. Appropriate data sources are 

discussed in Chapter 6 and example analyses of two sample data sets are given in 

Chapter 7. 

The statistical model used in ROSTER is presented in the Journal of Agricultural, 

Biological, and Environmental Statistics. A second paper discussing the different types of 

transportation effects measures estimated by ROSTER is available in the North American 

Journal of Fisheries Management. The two papers are listed below and are available on 

the Columbia Basin Research (CBR) webpage. 

Buchanan, R. A., Skalski, J. R., and Smith, S. G. 2006. “Estimating the effect of 

transportation from different vantage points and management perspectives,” North 

American Journal of Fisheries Management 26: 460–472. 

Buchanan, R. A., and Skalski, J. R. 2007. “A migratory life-cycle release-recapture 

model for salmonid PIT-tag investigations,” Journal of Agricultural, Biological, and 

Environmental Statistics 12: 325–345. 

  

http://www.cbr.washington.edu/analysis/apps/roster
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2.0 Running ROSTER 

2.1 Program ROSTER 

ROSTER is designed to be easy to use while providing full computational 

capabilities to the expert user. The process can be broken down into three main steps: 

loading the data, defining the model file, and running the estimation routine. 

2.2 Obtaining ROSTER 

ROSTER can be downloaded as a pre-compiled binary for Windows from the 

ROSTER webpage. The program is distributed as an .msi file named “ROSTERx.x…” 

where x.x… is the version number. Several data files used in examples throughout this 

manual and in the associated instructional videos can also be found on the ROSTER 

webpage. 

2.3 Getting Started 

The initial program view is a splash screen that displays for a few seconds and 

then gives way to the main program interface. You can go directly to the program 

interface by clicking on the splash screen. The program interface has two tabs, labeled 

Data (Figure 2.1) and Estimation (Figure 2.2). The data set is loaded using the Data tab 

and the Estimation tab is used to define the model file and run the estimation routine. 

The program interface is the primary view of the program. It is here that the data set 

is loaded, the model is configured, and program status is displayed. Another view of the 

program is the Schematic view (Figure 2.3), which gives a graphical display of the study 

environment and is available only when a data set has been loaded. To show the 

Schematic view, use the View menu or the associated icon (⸦ symbol) in the program 

toolbar. The View menu and associated toolbar icon are shown in Figure 2.4.  

https://www.cbr.washington.edu/analysis/apps/roster
https://www.cbr.washington.edu/analysis/apps/roster
https://www.youtube.com/playlist?list=PLZMYuu5FtXGW8K2tC2UqpO-tUlEF0GFu5
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Figure 2.1. The Data tab on the program interface. 

 

Figure 2.2. The Estimation tab on the program interface. 
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Figure 2.3. Schematic view—6 juvenile sites and 2 adult sites. 

 

Figure 2.4. Toolbar icons. 

2.4 Data 

The first step in running ROSTER is to load the data on the Data tab of the 

program interface (Figure 2.5). The Data tab has three sections: File, Description, and 

Preview. A Messages window appears at the base of the program interface. In the File 

section, the data file containing the capture histories is selected by clicking on the ... 
button and navigating to the data file. In the Description section, certain parameters 

describing the capture histories are entered, including the number of juvenile sites in the 
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capture histories, the number of adult sites, and the number of age classes for returning 

adults. A Preview of the selected data file is provided to the right in the program 

interface as a quick reminder of the selected data file composition. When the Load 

button is clicked, the data will be loaded and two reports will be generated, available 

under the Reports menu on the Toolbar. The Data Summary report contains basic 

statistics from the data set and the Sufficient Statistics report shows the statistics with 

a more technical presentation. These reports are described in more detail in Section 

2.6. 

 

Figure 2.5. Step 1—Loading data. 

The ROSTER data file consists of rows of detection (or capture) histories, each 

row representing the detection history for one fish. Each detection history consists of 

fields separated by white space where a field represents the observation record for the 

fish at a particular capture site. Detection histories may be generated from PIT-tag data 

available from the Pacific States Marine Fisheries Commission’s PTAGIS database 

system using University of Washington’s PIT-tag processing software PitPro. 

The fields in the detection histories are separated into two groups: juvenile 

detections and adult detections. A juvenile field in the detection history will have one of 

four values: 0, 1, 2, or 3 representing not detected, detected and returned to river, detected 

and removed from the migrating population, or detected and transported, respectively. 

An adult detection history field consists of either 0, meaning not detected, or the letter A, 

https://www.cbr.washington.edu/analysis/apps/pitpro
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a, B, b, C, c, D, d, E, or e. The letters indicate both detection and age class of the 

detected returning adult, with A indicating the first age class (ocean-1 fish), B the second 

age class, etc. Capital letters indicate that the adult was returned to the river after 

detection and lowercase letters indicate known removal (i.e., “censoring”) of the adult 

upon detection. All potential symbols are listed in Table 2.1. 

When running PitPro to process PIT-tag data for Program ROSTER, the user must 

include two extra types of PTAGIS files, a recovery file and a mortality file. Without these 

extra files, PitPro will not be able to identify removed tags and survival probabilities will 

not be adjusted for known removals. For more detail on how to prepare PTAGIS files for 

Program ROSTER, refer to the CBR PitPro webpage. 

The number of juvenile sites, adult sites, and adult age classes for the data set 

must be entered in the appropriate boxes before loading the data. The message window at 

the bottom of the program interface indicates when the data file has finished loading 

(Figure 2.1).  

https://www.cbr.washington.edu/analysis/apps/pitpro
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Table 2.1. Detection history symbols used by ROSTER 

Symbol Life Stage Meaning 
0 Both Not detected 

1 Juvenile Detected and returned to river 

2 Juvenile Detected and removed or detected but outcome unknown 

3 Juvenile Detected and transported 

A Adult Detected as age class 1 adult and returned to river 

a Adult Detected as age class 1 adult and removed 

B Adult Detected as age class 2 adult and returned to river 

b Adult Detected as age class 2 adult and removed 

C Adult Detected as age class 3 adult and returned to river 

c Adult Detected as age class 3 adult and removed 

D Adult Detected as age class 4 adult and returned to river 

d Adult Detected as age class 4 adult and removed 

E Adult Detected as age class 5+ adult and returned to river 

e Adult Detected as age class 5+ adult and removed 

2.5 Estimation 

Once the data set has been loaded, click on the Estimation tab in the program 

interface (Figure 2.2). The Estimation tab has three sections: Model Definition, 

Parameters Set by the User, and Estimate. The Messages window remains at the bottom 

of the program interface. 

2.5.1 Model Definition 

The first step of the estimation process is defining and loading the model on the 

Estimation tab (Figure 2.6). ROSTER provides a default model, based on statistics 

compiled from the data set and the adult site to which transportation effects will be 

calculated (Extent of Transportation Effects, Chapter 3.2). Alternatively, the expert user 

may modify the default model by saving the model file generated by ROSTER, editing it, 
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and loading the new model file. More information on this is given below and in Chapters 

4.1, 5, and 7. The selected model is loaded by clicking on the Load button. 

The model used in ROSTER is a statistical likelihood that is fit to the data to 

estimate juvenile, ocean, and adult survival probabilities of transported and non-

transported fish, juvenile and adult detection and censoring probabilities, and transportation 

parameters. The most general, or “full,” statistical model estimates separate values for 

each of these parameters, distinguishing between transported and non-transported fish and 

among transport groups in classifying adult parameters. It is often both difficult and 

unnecessary to treat all parameters as unique. Instead, it may be sufficient to equate 

certain model parameters. In particular, it may be reasonable to equate adult parameters 

among all transported fish, or perhaps for all fish, regardless of juvenile migration method 

(transport or non-transport). 

Program ROSTER is designed to run with as little input from the user as possible. 

A default statistical model is configured automatically by the program based on 

observed statistics from the data. This model will be a simplified version of the full 

model, tailored to the data set. The default model generated by ROSTER estimates 

unique upriver adult survival parameters for fish transported as juveniles and those not 

transported as juveniles until the site selected in the Extent of Transportation Effects 

window. The default model also estimates unique adult detection and censoring 

parameters for transported and non-transported fish at all adult detection sites up to the 

site identified as the extent of transportation effects. Additionally, the default model 

identifies which parameters to estimate and sets initial values for those parameters to be 

used by the estimation routine. In many cases, the default model will be sufficient for 

complete data analysis, in which case it is not necessary to save or edit a model definition 

file. To use the default model, make sure that the Default Model button is clicked on 

the Estimation tab, and click on the Load button. Alternatively, the default model may 

be used as a starting point for user-defined models. 
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Figure 2.6. Step 2—Defining the model. 

If the user chooses to modify the default model, then it is necessary to save and edit 

the model definition file. The model file is used by ROSTER to define changes in the 

structure of the statistical model compared to the full model described above; the 

statistical model used by ROSTER is not itself shown in the model file. In general, the 

changes defined in the model file consist of (1) equating parameters, (2) fixing 

parameters to a particular number, or (3) specifying the initial values (“seeds”) to be 

used in fitting the model. The model file also specifies the number of juvenile and adult 

detection sites and adult age classes, as entered on the Data tab of the ROSTER 

interface, as well as the site identified as the extent of transportation effects on the 

Estimation tab. User-specified values for untagged transport parameters and barge 

transport survival are also listed in the model definition file. 

After the default model is selected and loaded, it can be saved in a model file and 

edited. To save a copy of the model definition file for the default model, select Save 
Model Definition... from the File menu. The file can then be edited using an .xml editor 

or any text editor. The user may edit the model file by changing the parameters that are 

equated, fixing parameters so that they are not estimated, removing parameters from the 

list of fixed parameters so that they are estimated, or setting initial values. For guidance on 

fitting models, refer to Chapter 4.1. 

Once the model file has been edited and saved, it is available for use by the 

program. Click the button next to Model Definition File in the Model Definition section 

and select the file by clicking on the ... button. After selecting the desired model definition 

file, click on the Load button to load the model. 

With the model loaded, two more reports are available under the Reports menu: the 
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Parameters report shows initial values for estimation using the loaded model, and the 

Parameter Indices report shows the structure of the model. These reports are 

described in more detail in Section 2.6. 

2.5.2 Parameters Set by the User 

The second section of the Estimation tab allows the user to modify values of 

parameters that are always fixed in ROSTER, rather than estimated (Figure 2.7). These 

fixed parameters do not affect the model fit or estimates of the model parameters, but 

they are used in calculating estimates for certain performance measures. The first set of 

fixed parameters pertains to estimating transportation effect measures for untagged fish, 

under the heading Untagged Transport (see Chapter 3 for more details). The 

parameters to be set are the dam-specific transportation probabilities for untagged fish, 

representing the proportion of the collected untagged fish that are transported from each 

juvenile detection site (i.e., dam). The default values are 1 (100% transported) at 

transport dams, and 0 at other juvenile sites. The default variance is 0 for each 

parameter. The user may enter different values and positive variances if available. The 

second parameter set by the user is the Barge Transport Survival, or the survival 

probability of transported fish on the barge (or truck) during transportation. This 

parameter is used to estimate various measures of D, differential mortality. The default 

value of Barge Transport Survival is 0.98 (98%), with a Variance of 0. The user may alter 

the survival parameter or enter a positive variance for the survival parameter, if 

available. 

 

Figure 2.7. Setting parameters for untagged transport and barge transport survival. 
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Whether the user loads the default model or a model definition file, the loaded 

model should specify values for the untagged transport parameters and the barge 

transport survival. When the model is loaded, the Parameters Set by the User section 

of the ROSTER interface will show the values specified in the loaded model. The user 

may change the values of the untagged transport parameters and the barge transport 

survival and their variances by highlighting the appropriate box in the ROSTER interface 

and editing the values. Clicking the Cancel button will revert the parameters to their 

previously saved values, while clicking the Defaults button will revert the parameters to 

their default values. The user must tell ROSTER to apply the values from the interface if 

they have been changed, either by clicking the Apply button or by clicking Estimate 
Parameters and selecting Save from the dialog box that opens. Either action will tell 

ROSTER to calculate performance measures using the new values for the untagged 

transport parameters and barge transport survival, but without overwriting the values saved 

in the model definition file. In order to save a version of the model definition file with the 

new values of the user-set parameters, the user must first click Apply and then select 

Save Model Definition... under the File menu. 

2.5.3 Estimation 

The final step of the estimation process is to run the estimation routine (Figure 2.8) 

by clicking Estimate Parameters. Program status and any error messages are 

displayed in the message window at the bottom of the program interface. The function 

value reported in the message window is the negative log-likelihood value for the current 

iteration; this value depends on the parameter values being used and is minimized by the 

estimation routine. An extremely large function value such as 1.8e+308 indicates an error in 

the model file or estimation routine. A final message of success or failure of the estimation 

routine is shown in the message window. If the estimation routine fails to converge, then 

an error message appears and it is necessary to reload the model in order to examine 

reports or attempt to rerun the estimation routine. 
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Figure 2.8. Running the estimation routine. 

2.6 Reports 

Several types of reports are generated by ROSTER throughout the data loading 

and estimation process and are available under the Reports menu (Figure 2.9). Once 

the data set is loaded, the Data Summary and Sufficient Statistics reports are 

generated. After the model is loaded, the Parameters report and Parameter Indices 

report are available. After the estimation routine has been successfully run, the 

Estimation Results report and Covariance Matrix report are also available, as well as 

text files containing estimates of the model parameters and performance measures. 

 

Figure 2.9. The Reports menu. 

2.6.1 Data Summary Report 

After the data set has been successfully loaded, a data summary is available by 
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selecting Data Summary from the Reports menu. The data summary provides a useful 

report of basic statistics including size of the release group, number of detections at each 

juvenile site, number of detections at each adult site classified by juvenile transport group 

and adult age class, number of fish transported at each juvenile site, and number 

censored at each juvenile site and at each adult site classified by juvenile transport 

group and adult age class. The Data Summary report gives a quick, useful overview of 

the data set. 

2.6.2 Sufficient Statistics Report 

A more detailed and technical version of the Data Summary report, the Sufficient 
Statistics report is useful mostly for the expert user fitting a model other than the default 

model. The Sufficient Statistics report shows the statistics based on the data that the 

statistical model actually uses. Table 2.2 describes the nature of the sufficient statistics 

in this report. 
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Table 2.2. Statistics listed in Sufficient Statistics report. Detection sites are numbered 

consecutively. Site 0 is the initial release location, 𝑣𝑣 is the number of juvenile sites, 𝑢𝑢 is the 

number of adult sites, and 𝑤𝑤 is the number of adult age classes. Site 𝑣𝑣 + 1 is the first adult 

site, and site 𝑣𝑣 + 𝑢𝑢 is the last adult site. 

Statistic Definition 
𝑎𝑎𝑖𝑖 = number of juveniles detected at site 𝑖𝑖 (includes those transported from 𝑖𝑖 or 

removed at 𝑖𝑖); 𝑖𝑖 = 1, . . . , 𝑣𝑣 

𝑎𝑎𝑖𝑖𝑖𝑖𝑖𝑖 = number of non-transported fish detected at site 𝑖𝑖 as an age-𝑗𝑗 adult; 

 𝑖𝑖 = 𝑣𝑣 + 1, . . . , 𝑣𝑣 + 𝑢𝑢;  𝑗𝑗 = 1, . . . ,𝑤𝑤 

𝑎𝑎𝑖𝑖𝑖𝑖𝑇𝑇𝑘𝑘 = number of site-𝑘𝑘 transport fish detected at site 𝑖𝑖 as an age-𝑗𝑗 adult; 

 𝑖𝑖 = 𝑣𝑣 + 1, . . . , 𝑣𝑣 + 𝑢𝑢;  𝑗𝑗 = 1, . . . ,𝑤𝑤;  𝑘𝑘 = 1, . . . , 𝑣𝑣 

𝑏𝑏𝑖𝑖 = number of juveniles detected at site 𝑖𝑖, re-released to the river, and detected 

at a later site (juvenile or adult); 𝑖𝑖 = 0, . . . , 𝑣𝑣 

𝑏𝑏𝑖𝑖𝑖𝑖 = number of juveniles detected and transported from site 𝑖𝑖 and detected later 

at an adult site; 𝑖𝑖 = 1, . . . , 𝑣𝑣 

𝑏𝑏𝑖𝑖𝑖𝑖𝑖𝑖 = number of non-transport fish detected and re-released to the river at site 𝑖𝑖, 

and next detected as an age-𝑗𝑗 adult; 𝑖𝑖 = 0, . . . , 𝑣𝑣 + 𝑢𝑢 − 1;  𝑗𝑗 = 1, . . . ,𝑤𝑤 

𝑏𝑏𝑖𝑖𝑖𝑖𝑖𝑖 = number transported from juvenile site i and next detected as an age-𝑗𝑗 adult; 

𝑖𝑖 = 1, . . . , 𝑣𝑣;  𝑗𝑗 = 1, . . . ,𝑤𝑤  

𝑏𝑏𝑖𝑖𝑖𝑖𝑇𝑇𝑘𝑘 = number of site-𝑘𝑘 transport fish detected and re-released to the river at site 

𝑖𝑖 as an age-𝑗𝑗 adult, and detected later as age-𝑗𝑗 adult; 𝑖𝑖 = 𝑣𝑣 + 1, . . . , 𝑣𝑣 +

𝑢𝑢 − 1;  

𝑗𝑗 = 1, . . . ,𝑤𝑤;  𝑘𝑘 = 1, . . . , 𝑣𝑣 

𝑑𝑑𝑖𝑖 = number of juveniles censored (removed) at site 𝑖𝑖; 𝑖𝑖 = 1, . . . , 𝑣𝑣 

𝑑𝑑𝑖𝑖𝑖𝑖𝑖𝑖 = number of non-transported fish censored (removed) as age-𝑗𝑗 adults at site 𝑖𝑖;  

𝑖𝑖 = 𝑣𝑣 + 1, . . . , 𝑣𝑣 + 𝑢𝑢 − 1;  𝑗𝑗 = 1, . . . ,𝑤𝑤  

𝑑𝑑𝑖𝑖𝑖𝑖𝑇𝑇𝑘𝑘 = Number of site-𝑘𝑘 transport fish censored (removed) as age-𝑗𝑗 adults at site 𝑖𝑖; 

𝑖𝑖 = 𝑣𝑣 + 1, . . . , 𝑣𝑣 + 𝑢𝑢 − 1;  𝑗𝑗 = 1, . . . ,𝑤𝑤;  𝑘𝑘 = 1, . . . , 𝑣𝑣  

ℎ𝑖𝑖 = number of juveniles transported from site 𝑖𝑖; 𝑖𝑖 = 1, . . . , 𝑣𝑣 

𝑔𝑔𝑖𝑖 = number of fish not transported from any site 𝑘𝑘 ≤  𝑖𝑖 that are detected after 
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juvenile site 𝑖𝑖 (includes fish transported from sites after site 𝑖𝑖); 𝑖𝑖 = 0, . . . , 𝑣𝑣 −

1 

𝑔𝑔𝑖𝑖𝑖𝑖𝑖𝑖 = number of non-transported fish detected after site 𝑖𝑖 as age-𝑗𝑗 adults; 

𝑖𝑖 = 𝑣𝑣, . . . , 𝑣𝑣 + 𝑢𝑢 − 1;  𝑗𝑗 = 1, . . . ,𝑤𝑤  

𝑔𝑔𝑖𝑖𝑖𝑖𝑇𝑇𝑘𝑘 = number of site-𝑘𝑘 transport fish detected after site 𝑖𝑖 as age-𝑗𝑗 adults; 

𝑖𝑖 = 𝑣𝑣 + 1, . . . , 𝑣𝑣 + 𝑢𝑢 − 1;  𝑗𝑗 = 1, . . . ,𝑤𝑤;  𝑘𝑘 = 1, . . . , 𝑣𝑣  

2.6.3 Parameters Report 

The Parameters report is available in a preliminary version after the model has 

been loaded, and in a completed version after successfully running the estimation routine. 

Before running the estimation routine, the preliminary report shows the method of moments 

(MoM) estimates for each parameter, with all adult parameters showing the same estimate 

across transport and non-transport groups. The MoM estimate is usually a good educated 

“guess” as a starting value for the parameter for the estimation routine. The first time the 

estimation routine is run using the default model, these MoM estimates are used as initial 

values or “seeds.” The Parameters report also indicates which parameters are fixed rather 

than estimated and the value at which they are fixed. If the default model does not run 

successfully, the Parameters report may indicate where the problem is. For example, if 

the MoM estimate for a parameter is 0 or infinite (“inf”), then the default model will not run 

properly and the user will need to modify the model file. 

After the estimation routine has successfully completed, the Parameters report 

shows three values for each parameter: the MoM estimate, the Seed (initial value) 

actually used, and the final maximum likelihood estimate (MLE, shown as Estimate) 

found by the estimation routine. Unless the user tells ROSTER otherwise, the MoM 

estimate and the Seed will be equal. In many cases, the MoM estimate and the MLE 

Estimate will be equal as well. 

Certain ROSTER features allow the user to alter the initial values used in running 

the model. In these cases, the Seed value shown in the Parameters report will be different 

from the MoM estimates. It may still be the case that the MLE Estimate is equal, or nearly 
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equal, to the MoM estimate for each parameter. Running the estimation routine many 

times with different starting values is a good way to check that the estimation routine has 

correctly found the true maximum likelihood estimates. 

2.6.4 Parameter Indices 

The Parameter Indices report is available after the model is loaded. It indicates the 

structure of the loaded model by showing which Parameter values are estimated and 

which parameters are fixed (not estimated). Estimated parameters show a number in the 

Index column; equated parameters share a common index. 

2.6.5 Estimation Results Report 

Upon successful completion of the estimation process, the program will generate and 

display an Estimation Results report which includes estimates of the parameters and 

performance measures. This report can also be shown by selecting Estimation Results 

under the Reports menu. Performance measures that exclude jacks are shown at the 

bottom of the report. Model parameters and performance measures are described in 

detail in Chapter 3. 

2.6.6 Covariance Matrix 

The Covariance Matrix report gives the variance-covariance matrix estimated for the 

model parameters by ROSTER. Each entry in the matrix is the covariance between two 

parameter estimates. Only parameters that are actually estimated, not fixed, are included 

in the matrix. The Covariance Matrix report may be saved and then imported into other 

software for examination. 

2.6.7 Parameter Estimates and Performance Measures 

The Parameter Estimates and Performance Measures reports list the Estimate 

values and standard errors (s.e.) of all possible model parameters and performance 

measures, respectively, in simple text files that may be saved and imported into other 
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software. They are available under the Reports menu. 

2.7 Diagnostic Tools 

Program ROSTER includes several tools designed to help the user find the best 

model fit. In general, the initial values calculated by ROSTER will be very close, if not 

equal, to the actual MLEs. However, the MoM estimators used by ROSTER as initial 

values will not always provide the best model fit and in some cases they will not be the 

best initial values. Also, it is possible that the estimation routine misses the best model fit 

because of the step size used or because it ended too soon. These problems can be 

detected and avoided using ROSTER’s diagnostic tools. 

Program ROSTER uses the optimization routine Fletch (see Fletcher 1970 for 

more information on “Fletch optimization”) to find the MLEs as its default optimizer, 

though Direction Set (Powell’s), Simplex, and Quasi Newton (FBSG) are also 

available. The Optimizer type, Maximum Iterations, Precision, Proportional step size, 

and Ending criterion can be changed under Configure on the Toolbar and then selecting 
Optimizer (Figure 2.10). In general, a smaller precision makes the stopping criterion more 

stringent for the optimization routine. The step size indicates how large a change in each 

parameter is considered between iterations. If the step size is too large, the optimizer may 

“step over” the true MLE and never find it. If the step size is too small, the optimizer 

may not be able to leave the initial values (seeds) even when the true MLE is elsewhere. 

Thus, it is wise to rerun the estimation routine several times, varying the step size with a 

fairly small precision. The default values for precision and step size are both 10−6. 

  

https://doi.org/10.1093/comjnl/13.3.317
https://doi.org/10.1093/comjnl/13.3.317
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Figure 2.10. The Optimizer Setup dialog. 

In addition to changing the Fletch parameters, the user may use alternative seeds 

(initial values) to start the optimization. This can be useful; if different seeds lead to 

different final estimates, then the optimizer may be missing the correct MLE. The 

Parameters report is useful for keeping track of the seeds used and the final estimates 

found when using these tools. Under the Diagnostics menu is the Parameter Seeds... 
option, which allows the user to introduce random noise into the default MoM seeds (Figure 

2.11). To introduce random noise into the parameter seeds, select Introduce random 
noise to initial seeds, select either Proportional (default) or Absolute type, and enter 

the Amount of noise desired. If parameters are very close to boundaries (e.g., 0 or 1), 

then a large amount of noise may lead to sets of initial parameter values that are not 

viable. In these cases, running the estimation routine will lead to an error message. 

Rerunning the estimation routine may produce a set of random initial values that are 

viable, or it may be necessary to reduce the amount of random noise introduced to the 

seeds. In order to turn off the random noise in the seeds, unselect Introduce random noise 
to initial seeds and click OK. Alternatively, the user may specify seeds in the model file; 

see Section 5.4.  
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Figure 2.11. Introduce random noise to initial seeds on either a proportional or absolute 

scale.  



25  

3.0 ROSTER Theory 

3.1 The Model Behind ROSTER 

Historically, juvenile and adult PIT-tag data have been analyzed separately, and 

records of transported smolts have been removed (censored) from PIT-tag data to estimate 

smolt survival. The results of these separate analyses can be inefficient and deceptive. 

A PIT-tag release-recapture model was developed (see Buchanan et al. 2006 and 

Buchanan and Skalski 2007) that models the life cycle of Pacific salmonids from the 

initiation of the juvenile migration as smolts to the end of the spawning migration as 

adults. This model jointly analyzes juvenile and adult PIT-tag data and uses both 

juvenile and adult data from transported individuals. Multiple performance measures for 

monitoring the juvenile and adult migrations and assessing recovery efforts are estimated by 

the model, including juvenile inriver survival, ocean survival, adult inriver survival, 

transportation effects (e.g., 𝑇𝑇/𝐼𝐼, 𝐷𝐷), smolt-to-adult ratios (𝑆𝑆𝑆𝑆𝑆𝑆), and adult age 

composition. 

This model is appropriate for spring and summer Chinook salmon, Sockeye 

salmon, and Steelhead. Because the model does not accommodate the overwintering 

behavior of fall Chinook salmon, data from this species should not be analyzed with this 

model. The life-cycle model primarily uses detections of PIT tags at dams but can also 

use detections at hatcheries or spawning sites, if available. The model uses branching 

migration paths to capture the age structure of returning adults. Figure 3.1 shows a 

schematic of the migration paths used by the life-cycle model. Survival (𝑆𝑆) and detection 

probabilities (𝑝𝑝) can be estimated at each detection site; joint survival and detection (𝜆𝜆) 

can be estimated at the last site. Smolts in the release group move downstream along a 

single path but branch into one of several paths in the ocean based on maturation rates 

and transport history. Each branch represents a particular adult age class; these are kept 

separate throughout the adult spawning migration. While Figure 3.1 shows only three age 

classes, ROSTER can accommodate up to five age classes. 

https://doi.org/10.1577/M05-080.1
https://doi.org/10.1198/108571107X229331
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Figure 3.1. Schematic of migration paths for model with 3 juvenile sites, 3 adult sites, and 3 

adult age classes 

In addition to multiple adult age classes, the life-cycle model also incorporates 

transportation and is able to estimate transportation effects directly. Adult detections of 

transported fish are used to compare the return probabilities of transported and non-

transported fish. Figure 3.2 shows a schematic of the migration paths of the transported 

and inriver fish; each ocean and adult pathway represents multiple return years. The 

model also accounts for censoring of juveniles and adults due to known removals at dams. 

 

Figure 3.2. Schematic of migration paths of transported and inriver fish for model with 3 

juvenile sites, 3 adult sites, and transportation at the first 2 juvenile sites. Each ocean and 

adult migration path represents multiple return years. 
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Table 3.1 lists the parameters used in the release-recapture model and estimated by 

ROSTER. The parameter estimators are maximum likelihood estimators, with the 

desirable properties of asymptotic unbiasedness, efficiency, and normality. All combinations 

of the basic model parameters (e.g., the performance measures in Section 3.4) are also 

maximum likelihood estimators. 

Table 3.1. Model parameters estimated by ROSTER. The number of juvenile detection sites is 

𝑣𝑣, the number of adult detection sites is 𝑢𝑢, and the number of adult age classes is 𝑤𝑤. 

Parameter Definition 
𝑆𝑆1 = probability of survival from release point to first detection site 

𝑆𝑆𝑖𝑖 = conditional probability of survival from detection site 𝑖𝑖 − 1 to detection 

site 𝑖𝑖 (𝑖𝑖 = 2, . . . , 𝑣𝑣) for non-transported fish 

𝑆𝑆𝑣𝑣+1,𝑗𝑗𝑗𝑗 = conditional joint probability of surviving from site 𝑣𝑣 (last juvenile site) to site 

𝑣𝑣 + 1 (first adult site) and returning to site 𝑣𝑣 + 1 in adult age class 𝑗𝑗 (𝑗𝑗 =

1, . . . ,𝑤𝑤) for non-transported fish 

𝑆𝑆𝑖𝑖𝑖𝑖𝑖𝑖 = conditional probability of surviving from adult site 𝑖𝑖 − 1 (𝑖𝑖 = 𝑣𝑣 + 2, . . . , 𝑣𝑣 +

𝑢𝑢 − 1) to site 𝑖𝑖 for non-transported fish in adult age class 𝑗𝑗 (𝑗𝑗 =

 1, . . . ,𝑤𝑤) 

𝑆𝑆𝑖𝑖𝑖𝑖𝑇𝑇𝑙𝑙 = conditional probability of surviving from adult site 𝑖𝑖 − 1 (𝑖𝑖 = 𝑣𝑣 + 2, . . . , 𝑣𝑣 +

𝑢𝑢 − 1) to site 𝑖𝑖 for fish transported at site 𝑙𝑙 (𝑙𝑙 = 1, . . . , 𝑣𝑣) as juveniles and 

returning in adult age class 𝑗𝑗 (𝑗𝑗 = 1, . . . ,𝑤𝑤) 

𝑝𝑝𝑖𝑖 = conditional probability of detection at juvenile site 𝑖𝑖 (𝑖𝑖 = 1, . . . , 𝑣𝑣), given 

survival to site 𝑖𝑖 inriver (i.e., non-transported) 

𝑝𝑝𝑖𝑖𝑖𝑖𝑖𝑖 = conditional probability of detection at adult site 𝑖𝑖 (𝑖𝑖 = 𝑣𝑣 + 1, . . . , 𝑣𝑣 + 𝑢𝑢 −

1), given survival to site 𝑖𝑖, for non-transported fish in age class 𝑗𝑗 (𝑗𝑗 =

1, . . . ,𝑤𝑤) 

𝑝𝑝𝑖𝑖𝑖𝑖𝑇𝑇𝑙𝑙 = conditional probability of detection at adult site 𝑖𝑖 (𝑖𝑖 = 𝑣𝑣 + 1, . . . , 𝑣𝑣 + 𝑢𝑢 −

1), given survival to site 𝑖𝑖, for fish transported from site 𝑙𝑙 (𝑙𝑙 = 1, … , 𝑣𝑣) 

and returning in age class 𝑗𝑗 (𝑗𝑗 = 1, . . . ,𝑤𝑤) 

𝜆𝜆𝑗𝑗𝑗𝑗 = conditional probability of non-transported fish in age class 𝑗𝑗 (𝑗𝑗 =
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1, . . . ,𝑤𝑤) surviving to and being detected at the final adult site (site 𝑣𝑣 +

𝑢𝑢), given survival to the previous adult site (site 𝑣𝑣 + 𝑢𝑢 − 1) 

𝜆𝜆𝑗𝑗𝑇𝑇𝑙𝑙 = conditional probability of site-𝑙𝑙 transport fish (𝑙𝑙 = 1, . . . , 𝑣𝑣) in age class 

𝑗𝑗 (𝑗𝑗 = 1, . . . ,𝑤𝑤) surviving to and being detected at the final adult site 

(site 𝑣𝑣 + 𝑢𝑢), given survival to the previous adult site (site 𝑣𝑣 + 𝑢𝑢 − 1) 

𝑐𝑐𝑖𝑖 = conditional probability of being removed (censored) at juvenile site 𝑖𝑖 (𝑖𝑖 =

1, . . . , 𝑣𝑣), given detection at site 𝑖𝑖 

𝑐𝑐𝑖𝑖𝑖𝑖 = conditional probability of being removed (censored) at adult site 𝑖𝑖 (𝑖𝑖 = 𝑣𝑣 +

1, . . . , 𝑣𝑣 + 𝑢𝑢 − 1) for age class-𝑗𝑗 fish (𝑗𝑗 = 1, . . . ,𝑤𝑤), given detection at site 

𝑖𝑖 

𝑡𝑡𝑖𝑖 = conditional probability of being transported from site 𝑖𝑖 (𝑖𝑖 = 1, . . . , 𝑣𝑣), given 

detection at that site, and no censoring 

𝑅𝑅𝑖𝑖𝑖𝑖 = transport-inriver ratio (T/I) for fish transported from site 𝑖𝑖 (𝑖𝑖 = 1, . . . , 𝑣𝑣) and 

returning to the first adult site in adult age class 𝑗𝑗 (𝑗𝑗 = 1, . . . ,𝑤𝑤); defines 

survival of transported fish relative to survival of non-transported fish 

3.2 Extent of Transportation Effects 

It is possible that effects of juvenile transportation extend through part or all of the 

adult migration. For example, juvenile transportation may affect adult straying rates; this 

would result in different adult inriver (perceived) survival probabilities for transported and 

non-transported groups. ROSTER has the ability to fit a model that estimates the effects 

of juvenile transportation on upriver adult survival, detection, and censoring probabilities. 

If transportation effects really end at the first adult site, however, the extra complexity in the 

model that estimates upriver effects will detract from the information that can be learned 

from the data set. Thus, the user can tell ROSTER which adult site should represent the 

extent of the effects of juvenile transportation and, using model selection tools (e.g., 

Likelihood Ratio Tests [LRT] or Akaike’s Information Criterion [AIC]), determine the model 

with the appropriate extent of transportation effects. 

The user tells ROSTER what the extent of the transportation effects should be by 

changing the value in the Extent of Transportation Effects window. The default value 
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for the extent of transportation effects is the first adult site, because this relatively simple 

model is generally easier to fit than models that incorporate upriver transportation 

effects. Because juvenile and adult sites are numbered sequentially, the first adult site is 

one more than the number of juvenile sites. With 6 juvenile sites, the extent of 

transportation effects value will be 7 by default. 

For example, for a data set with adult detections at Bonneville, McNary, Ice Harbor, 

and Lower Granite dams, ROSTER by default assumes that transportation effects end 

at Bonneville and that adult survival, detection, and censoring probabilities upstream of 

Bonneville do not depend on the juvenile migration method (transportation or inriver). If 

the user wishes to investigate transportation effects on the adult migration up to McNary, 

then the value in the Extent of Transportation Effects window should be changed to the 

index of the second adult site (i.e., to 8 if there are 6 juvenile sites). If the user wishes to 

investigate transportation effects throughout the entire adult migration, then the extent of 

transportation effects value should be changed to the last adult site (Lower Granite Dam, site 

10 if there are 6 juvenile sites). After changing the value in the Extent of 
Transportation Effects window, the default model must be loaded in order for ROSTER 

to use the correct model. 

The model parameters for adult survival, detection, and censoring vary between 

transport and non-transport groups up to but not including the site that is identified as the 

extent of transportation effects. Thus, if transportation effects are measured to the first 

adult site (Bonneville), then only ocean survival varies between transport and non-

transport groups. If transportation effects are measured to the second adult site (e.g., 

McNary), then detection and censoring probabilities at Bonneville and survival between 

Bonneville and McNary vary with transport group. Upstream of the adult site identified as 

the extent of transportation effects, inriver survival and detection are assumed to be the 

same regardless of juvenile migration method (transportation or inriver). By default, 

ROSTER does not differentiate among transport groups in estimating upriver adult 

parameters. However, the expert user may modify the model definition file in order to 

compare, for example, upriver adult survival parameters for the different transport groups. 
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3.3 Tagged Versus Untagged Fish 

Estimates of the model parameters and the performance measures are directly 

applicable only to the tagged fish in the release group. However, it is typical to assume 

that the tagged release group is representative of the untagged fish from the same 

populations that are migrating at the same time as the release group. If the fish selected 

for tagging are assumed to be representative of the migrating group from the same 

population, then the estimated values of the model parameters and some of the 

performance measures may be applied to those untagged fish. (Note that the validity of 

such nonstatistical inference depends on the degree to which the tagged group represents 

the untagged population of interest and is independent of the statistical model behind 

ROSTER.) Other performance measures must be modified for untagged fish. In particular, 

any performance measure that depends on the conditional transportation probabilities (i.e., 

𝑡𝑡𝑖𝑖) must be modified for untagged fish because tagged and untagged fish experience the 

transportation system differently. In general, all untagged fish that are bypassed at a 

transport dam are transported at that dam. However, some tagged fish are diverted 

from the bypass system back to the river rather than to the transport barges for study 

purposes. This means that for tagged fish, the conditional transportation probability is 

usually less than 1 (i.e., 𝑡𝑡𝑖𝑖 < 1), but for untagged fish, the conditional transportation 

probability is usually equal to 1. Letting 𝑡𝑡𝑖𝑖𝑈𝑈 be the conditional transportation probability for 

tagged fish, we typically have 𝑡𝑡𝑖𝑖𝑈𝑈 =  1. It is possible, however, that only a portion of 

untagged fish in the bypass system are transported, in which case 𝑡𝑡𝑖𝑖𝑈𝑈 will be less than 1. 

For example, transportation may be operated only on alternate days, which would be 

consistent with 𝑡𝑡𝑖𝑖𝑈𝑈 =  0.5. 

The performance measures derived explicitly for untagged fish use the values 𝑡𝑡𝑖𝑖𝑈𝑈 

rather than the model parameters 𝑡𝑡𝑖𝑖, and are labeled with the superscript 𝑈𝑈 to indicate 

“untagged”; otherwise, these performance measures are identical to those derived for 

tagged fish. The 𝑡𝑡𝑖𝑖𝑈𝑈 parameters cannot be estimated from tagging data but must come from 

other sources. The default values used in ROSTER are 𝑡𝑡𝑖𝑖𝑈𝑈 =  1 (𝑆𝑆𝑆𝑆 = 0) for sites where 

tagged fish were transported, and 𝑡𝑡𝑖𝑖𝑈𝑈 =  0 (𝑆𝑆𝑆𝑆 = 0) for sites where no tagged fish were 
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transported. The user may change both the 𝑡𝑡𝑖𝑖𝑈𝑈and the standard error values on the 

ROSTER interface; see Section 2.5.2 for more details. It should be noted that the direct 

statistical inference of performance measures using 𝑡𝑡𝑖𝑖𝑈𝑈 is to fish in the (tagged) release 

group, had they been treated as untagged fish. 

3.4 Performance Measures 

The performance measures estimated by ROSTER are defined here both 

heuristically and analytically in terms of the model parameters. In order to address the 

needs of as many users as possible, it has often been necessary to create several versions 

of the same type of performance measure. For example, consider a measure of 

transportation effects. It is possible to measure the effect of transportation from a single 

transport dam, either in the context of the entire transport system or else isolated from 

that system. Alternatively, the effects of the entire transport system may be measured 

with all transport dams considered. The transport effect measure may be either a relative 

measure (ratio) or an absolute measure (difference). The effect may be measured on 

return probabilities only to the adult site that has been identified in the model as the 

extent of the transport effects (𝐸𝐸), or all the way to the final adult site (𝑣𝑣 + 𝑢𝑢). The 

measure may be calculated for tagged fish or for untagged fish (that is, tagged fish treated 

as untagged fish), and finally, the measure may or may not include jacks. This gives us a 

multitude of different transport effect measures to choose from. In what follows, most of 

the different types of measures are shown explicitly. Each of the measures defined below 

that include multiple age classes also includes jacks (age-1 adults, or ocean-1 fish). Not 

shown are separate measures that exclude the jacks. ROSTER reports measures both with 

and without jacks; the formulas for those that exclude jacks can be derived easily from 

the formulas that follow by restricting the index 𝑗𝑗 to 𝑗𝑗 > 1. 

In the following sections, 𝑣𝑣 is the number of juvenile detection sites, 𝑢𝑢 is the number 

of adult detection sites, and 𝑤𝑤 is the number of adult age classes. The index 𝐸𝐸 indicates 

the adult site where the model assumes the juvenile transport effects end (Extent of 
Transportation Effects, see Section 3.2). The default value of 𝐸𝐸 is the first adult 

detection site, typically Bonneville. The index 𝐸𝐸 follows the consecutive numbering 
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format of juvenile and adult sites used by the model; thus, the possible values of 𝐸𝐸 range 

from site 𝑣𝑣 + 1 (first adult site) to site 𝑣𝑣 + 𝑢𝑢 (last adult site). Some performance measures 

involving adult return probabilities are indexed by 𝑘𝑘. The index 𝑘𝑘 is used to indicate the 

adult site to which returns are reported, with 𝑘𝑘 = 𝐸𝐸 or 𝑘𝑘 = 𝑣𝑣 + 𝑢𝑢. 

3.4.1 Transportation Effects 

Several types of transportation effect measures are estimated by ROSTER, 

including both site-specific (equivalently, dam-specific) and systemwide measures. The site-

specific measures assess the effects of transportation from a single dam, while the system-

wide measures assess the effects of the entire transportation system. Buchanan et al. 

(2006) discuss measures of transportation effects in more detail. 

3.4.1.1 Site-specific transportation effects measures 

All the site-specific transportation effect measures compare the return probabilities of 

transported and non-transported (control) fish with a transport-inriver ratio, T/I. The 

different measures vary in the assumptions made about the control fish and in whether 

they are applicable to tagged or untagged fish. Each measure is described and defined in 

terms of the model parameters below. In each case, the subscript 𝑖𝑖 (𝑖𝑖 =  1, . . . , 𝑣𝑣) indicates 

the site (dam) being considered, and the subscript 𝑗𝑗 (𝑗𝑗 =  1, . . . ,𝑤𝑤) indicates the adult 

age class being used. 

Isolated age-specific T/I (𝑅𝑅𝑖𝑖𝑖𝑖(𝑘𝑘)) 

The isolated age-specific T/I (𝑅𝑅𝑖𝑖𝑖𝑖(𝑘𝑘)) for juvenile site (or dam) 𝑖𝑖 and adult age class 

𝑗𝑗 is the ratio of the age-𝑗𝑗 return probability from site 𝑖𝑖 to adult site 𝑘𝑘 for site-𝑖𝑖 transport 

fish to that of fish passing site 𝑖𝑖 inriver, as if there were no further downstream 

transportation sites. The measure 𝑅𝑅𝑖𝑖𝑖𝑖(𝑘𝑘) estimates the relative age-𝑗𝑗 transportation effect 

at site 𝑖𝑖 isolated from the rest of the transportation system. The control fish for 𝑅𝑅𝑖𝑖𝑖𝑖(𝑘𝑘) are 

treated as if they had no possibility of being transported at sites downriver of site 𝑖𝑖. The 

measure 𝑅𝑅𝑖𝑖𝑖𝑖(𝑘𝑘) is valid for both tagged and untagged fish. 

If 𝑘𝑘 = 𝑣𝑣 + 1 or 𝐸𝐸 = 𝑣𝑣 + 1 (i.e., if Extent of Transportation Effects = 𝑣𝑣 + 1), then 

https://doi.org/10.1577%2FM05-080.1
https://doi.org/10.1577%2FM05-080.1
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𝑅𝑅𝑖𝑖𝑖𝑖(𝑘𝑘) = 𝑅𝑅𝑖𝑖𝑖𝑖, the model parameter representing site-𝑖𝑖 transportation effects on the return 

probability to the first adult site for age-𝑗𝑗 fish. If both 𝑘𝑘 > 𝑣𝑣 + 1 and 𝐸𝐸 > 𝑣𝑣 + 1, then 

𝑅𝑅𝑖𝑖𝑖𝑖(𝑘𝑘) = 𝑅𝑅𝑖𝑖𝑖𝑖
𝑆𝑆𝑣𝑣+2,𝑗𝑗𝑇𝑇𝑖𝑖 ··· 𝑆𝑆𝐸𝐸𝐸𝐸𝑇𝑇𝑖𝑖
𝑆𝑆𝑣𝑣+2,𝑗𝑗𝑗𝑗 ··· 𝑆𝑆𝐸𝐸𝐸𝐸𝐸𝐸

. (3.1) 

Note that 𝑅𝑅𝑖𝑖𝑖𝑖(𝑘𝑘) = 𝑅𝑅𝑖𝑖𝑖𝑖(𝐸𝐸) for all 𝑘𝑘 > 𝐸𝐸.  

Isolated T/I (𝑅𝑅𝑖𝑖(𝑘𝑘)) 

The isolated T/I �𝑅𝑅𝑖𝑖(𝑘𝑘)� for juvenile site 𝑖𝑖 is the ratio of the return probability from 

site 𝑖𝑖 to adult site 𝑘𝑘 for site-𝑖𝑖 transport fish to that of fish passing site 𝑖𝑖 inriver, as if there 

were no further downstream transportation sites. The measure 𝑅𝑅𝑖𝑖(𝑘𝑘) estimates the relative 

transportation effect at site 𝑖𝑖 isolated from the rest of the transportation system. The 

control fish for 𝑅𝑅𝑖𝑖(𝑘𝑘) are treated as if they had no possibility of being transported at sites 

downriver of site 𝑖𝑖. The measure 𝑅𝑅𝑖𝑖(𝑘𝑘) is valid for both tagged and untagged fish. This 

measure is analogous to the 𝑅𝑅𝑎𝑎𝑎𝑎𝑎𝑎𝑎𝑎 measure of Sandford and Smith (2002).  

𝑅𝑅𝑖𝑖(𝑘𝑘) =
∑ 𝑆𝑆𝑣𝑣+1,𝑗𝑗𝑗𝑗 ··· 𝑆𝑆𝑘𝑘𝑘𝑘𝑘𝑘𝑅𝑅𝑖𝑖𝑖𝑖(𝑘𝑘)
𝑤𝑤
𝑗𝑗=1

∑ 𝑆𝑆𝑣𝑣+1,𝑗𝑗𝑗𝑗 ··· 𝑆𝑆𝑘𝑘𝑘𝑘𝑘𝑘𝑤𝑤
𝑗𝑗=1

, (3.2) 

where 𝑤𝑤 is the number of adult age classes. Note that 𝑅𝑅𝑖𝑖(𝑣𝑣+1) =
∑ 𝑆𝑆𝑣𝑣+1,𝑗𝑗𝑗𝑗𝑅𝑅𝑖𝑖𝑖𝑖𝑤𝑤
𝑗𝑗=1
∑ 𝑆𝑆𝑣𝑣+1,𝑗𝑗𝑗𝑗
𝑤𝑤
𝑗𝑗=1

. 

Contextual T/I for tagged fish (𝑅𝑅𝑅𝑅𝑖𝑖(𝑘𝑘)) 

The contextual T/I for tagged fish 𝑅𝑅𝑅𝑅𝑖𝑖(𝑘𝑘) for juvenile site 𝑖𝑖 is the ratio of the return 

probability to adult site 𝑘𝑘 of site-𝑖𝑖 transport fish to that of fish passing site 𝑖𝑖 inriver. The 

measure 𝑅𝑅𝑅𝑅𝑖𝑖(𝑘𝑘) assesses transportation from site 𝑖𝑖 in the context of the entire downriver 

transportation system. The control fish for 𝑅𝑅𝑅𝑅𝑖𝑖(𝑘𝑘) may be transported at sites 

downstream of site 𝑖𝑖. Because 𝑅𝑅𝑅𝑅𝑖𝑖(𝑘𝑘) depends on the proportions of the control fish that 

are transported at downstream dams, it is valid only for tagged fish. This measure is 

analogous to the relative recovery measure historically used to measure transportation 

effects (see Ebel et al. 1973). 

https://doi.org/10.1198/10857110260141274
https://spo.nmfs.noaa.gov/sites/default/files/pdf-content/1973/712/ebel.pdf
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𝑅𝑅𝑅𝑅𝑖𝑖(𝑘𝑘) =
𝑅𝑅𝑖𝑖(𝑘𝑘)

∑ �𝑝𝑝𝑠𝑠𝑡𝑡𝑠𝑠𝑅𝑅𝑠𝑠(𝑘𝑘)[∏ (1 − 𝑝𝑝𝑥𝑥𝑡𝑡𝑥𝑥)𝑠𝑠−1
𝑥𝑥=𝑖𝑖+1 ]� + ∏ (1 − 𝑝𝑝𝑠𝑠𝑡𝑡𝑠𝑠)𝑣𝑣

𝑠𝑠=𝑖𝑖+1
𝑣𝑣
𝑠𝑠=𝑖𝑖+1

. (3.3) 

Contextual T/I for untagged fish (𝑅𝑅𝑅𝑅𝑖𝑖(𝑘𝑘)
𝑈𝑈 ) 

The contextual T/I for untagged fish (𝑅𝑅𝑅𝑅𝑖𝑖(𝑘𝑘)
𝑈𝑈 ) for juvenile site 𝑖𝑖 has the same 

meaning as 𝑅𝑅𝑅𝑅𝑖𝑖(𝑘𝑘), but is applicable to untagged fish (or to tagged fish if they had been 

treated as untagged). That is, under the assumption that tagged and untagged fish 

respond identically to transportation, then 𝑅𝑅𝑅𝑅𝑖𝑖(𝑘𝑘)
𝑈𝑈  is the ratio of the return probability to 

adult site 𝑘𝑘 from site 𝑖𝑖 of site-𝑖𝑖 transport fish to that of (untagged) fish passing site 𝑖𝑖 inriver. 

The control fish for 𝑅𝑅𝑅𝑅𝑖𝑖(𝑘𝑘)
𝑈𝑈  may be transported at sites downriver of site 𝑖𝑖. The rates at 

which the untagged control fish are transported at these sites are represented by the 𝑡𝑡𝑥𝑥𝑈𝑈 

values for all juvenile dams 𝑥𝑥 > 𝑖𝑖. 

𝑅𝑅𝑅𝑅𝑖𝑖(𝑘𝑘)
𝑈𝑈 =

𝑅𝑅𝑖𝑖(𝑘𝑘)

∑ �𝑝𝑝𝑠𝑠𝑡𝑡𝑠𝑠𝑈𝑈𝑅𝑅𝑠𝑠(𝑘𝑘)[∏ (1 − 𝑝𝑝𝑥𝑥𝑡𝑡𝑥𝑥𝑈𝑈)𝑠𝑠−1
𝑥𝑥=𝑖𝑖+1 ]� + ∏ (1 − 𝑝𝑝𝑠𝑠𝑡𝑡𝑠𝑠𝑈𝑈)𝑣𝑣

𝑠𝑠=𝑖𝑖+1
𝑣𝑣
𝑠𝑠=𝑖𝑖+1

. (3.4) 

3.4.1.2 Systemwide transportation effects measures 

Systemwide transportation effect measures assess the effect of the complete 

transportation system on return probabilities (to adult site 𝑘𝑘 = 𝐸𝐸 or 𝑘𝑘 = 𝑣𝑣 + 𝑢𝑢) of the 

entire release group. Rather than comparing return probabilities of transported fish to those 

of non-transported fish, systemwide measures compare the observed return probability of 

the release group to what the return probability would have been if there had been no 

transportation. Thus, systemwide measures are able to compare return probabilities 

under two strategies: transportation versus complete inriver migration. This comparison 

can be either a relative value (𝑅𝑅𝑠𝑠𝑠𝑠𝑠𝑠(𝑘𝑘) and 𝑅𝑅𝑠𝑠𝑠𝑠𝑠𝑠(𝑘𝑘)
𝑈𝑈 ) or an absolute value (𝑅𝑅𝑎𝑎𝑎𝑎𝑎𝑎(𝑘𝑘) and 

𝑅𝑅𝑎𝑎𝑎𝑎𝑎𝑎(𝑘𝑘)
𝑈𝑈 ). 

Systemwide T/I for tagged fish (𝑅𝑅𝑠𝑠𝑠𝑠𝑠𝑠(𝑘𝑘)) 

The systemwide T/I for tagged smolts (𝑅𝑅𝑠𝑠𝑠𝑠𝑠𝑠(𝑘𝑘)) is the ratio of the return 

probability from the release site to adult site 𝑘𝑘 for all smolts, transported or not, under 
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the existing transportation system to what the return probability would have been without the 

transportation system, i.e., under complete inriver migration. The measure 𝑅𝑅𝑠𝑠𝑠𝑠𝑠𝑠(𝑘𝑘) 

incorporates the proportion of the smolts reaching each dam that are transported. It 

combines the effects of transportation from all possible transport sites. It should be noted 

that 𝑅𝑅𝑠𝑠𝑠𝑠𝑠𝑠(𝑘𝑘) does not compare the return probability of transported smolts to the return 

probability of non-transported smolts, but rather compares the return probability of the 

entire release group (transported and inriver) to what that return probability would have been 

if there had been no transportation system. Because 𝑅𝑅𝑠𝑠𝑠𝑠𝑠𝑠(𝑘𝑘) depends on the proportion of 

smolts transported at each dam, it is valid only for tagged smolts. 

𝑅𝑅𝑠𝑠𝑠𝑠𝑠𝑠(𝑘𝑘) =
𝑃𝑃𝑃𝑃[Adult return to 𝑘𝑘 | Transportation system]
𝑃𝑃𝑃𝑃[Adult return to 𝑘𝑘 | No transportation system]

 

                = ��𝑝𝑝𝑖𝑖𝑡𝑡𝑖𝑖𝑅𝑅𝑖𝑖(𝑘𝑘) �(1 − 𝑝𝑝𝑥𝑥𝑡𝑡𝑥𝑥)
𝑖𝑖−1

𝑥𝑥=1

� + �(1− 𝑝𝑝𝑖𝑖𝑡𝑡𝑖𝑖).
𝑣𝑣

𝑖𝑖=1

𝑣𝑣

𝑖𝑖=1

(3.5) 

Systemwide T/I for untagged fish (𝑅𝑅𝑠𝑠𝑠𝑠𝑠𝑠(𝑘𝑘)
𝑈𝑈 ) 

The systemwide T/I for untagged smolts (𝑅𝑅𝑠𝑠𝑠𝑠𝑠𝑠(𝑘𝑘)
𝑈𝑈 )

 
is analogous to the value for 

tagged smolts (𝑅𝑅𝑠𝑠𝑠𝑠𝑠𝑠(𝑘𝑘)) but is applicable to untagged smolts of the same stock that 

migrated at the same time as the tagged group or to tagged smolts if they had been 

treated as untagged smolts. The measure 𝑅𝑅𝑠𝑠𝑠𝑠𝑠𝑠(𝑘𝑘)
𝑈𝑈

 
is a relative measure comparing the 

return probability from the release site to adult site 𝑘𝑘 for all smolts (of the same stock 

and timing), transported or not, under the existing transportation system to that of a non-

transportation system, i.e., complete inriver migration. The measure 𝑅𝑅𝑠𝑠𝑠𝑠𝑠𝑠(𝑘𝑘)
𝑈𝑈  depends on 

the proportions of untagged smolts transported at each dam, i.e., 𝑡𝑡𝑖𝑖𝑈𝑈 for juvenile site 𝑖𝑖. 

𝑅𝑅𝑠𝑠𝑠𝑠𝑠𝑠(𝑘𝑘)
𝑈𝑈 = ��𝑝𝑝𝑖𝑖𝑡𝑡𝑖𝑖𝑈𝑈𝑅𝑅𝑖𝑖(𝑘𝑘) �(1 − 𝑝𝑝𝑥𝑥𝑡𝑡𝑥𝑥𝑈𝑈)

𝑖𝑖−1

𝑥𝑥=1

� + ��1 − 𝑝𝑝𝑖𝑖𝑡𝑡𝑖𝑖𝑈𝑈�
𝑣𝑣

𝑖𝑖=1

𝑣𝑣

𝑖𝑖=1

. (3.6) 

Absolute systemwide transportation effect measure for tagged fish (𝑅𝑅𝑎𝑎𝑎𝑎𝑎𝑎(𝑘𝑘)) 
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The absolute measure (𝑅𝑅𝑎𝑎𝑎𝑎𝑎𝑎(𝑘𝑘)) is the difference between the return probability 

from the release point to adult site 𝑘𝑘 for the entire release group under the transportation 

system and what that return probability would have been without the transportation 

system. This measure is similar to 𝑅𝑅𝑠𝑠𝑠𝑠𝑠𝑠(𝑘𝑘) in that it compares the observed return 

probability to the hypothetical return probability if there had been no transportation. Like 

𝑅𝑅𝑠𝑠𝑠𝑠𝑠𝑠(𝑘𝑘), 𝑅𝑅𝑎𝑎𝑎𝑎𝑎𝑎(𝑘𝑘) is suitable only for tagged fish. Unlike 𝑅𝑅𝑠𝑠𝑠𝑠𝑠𝑠(𝑘𝑘), 𝑅𝑅𝑎𝑎𝑎𝑎𝑎𝑎(𝑘𝑘) reflects the absolute 

change in return probabilities due to transportation. 

𝑅𝑅𝑎𝑎𝑎𝑎𝑎𝑎(𝑘𝑘) = �𝑆𝑆1 ∙∙∙ 𝑆𝑆𝑣𝑣�𝑆𝑆𝑣𝑣+1,𝑗𝑗𝑗𝑗

𝑤𝑤

𝑗𝑗=1

∙∙∙ 𝑆𝑆𝑘𝑘𝑘𝑘𝑘𝑘� �𝑅𝑅𝑠𝑠𝑠𝑠𝑠𝑠(𝑘𝑘) − 1�. (3.7) 

Absolute systemwide transportation effect measure for untagged fish (𝑅𝑅𝑎𝑎𝑎𝑎𝑎𝑎(𝑘𝑘)
𝑈𝑈 )  

The absolute measure (𝑅𝑅𝑎𝑎𝑎𝑎𝑎𝑎(𝑘𝑘)
𝑈𝑈 ) is analogous to 𝑅𝑅𝑎𝑎𝑎𝑎𝑎𝑎(𝑘𝑘) but is applicable to 

untagged smolts of the same stock that migrated at the same time as the tagged group or 

to tagged smolts if they had been treated as untagged smolts. The measure 𝑅𝑅𝑎𝑎𝑎𝑎𝑎𝑎(𝑘𝑘)
𝑈𝑈  

reflects the absolute change in return probabilities (to adult site 𝑘𝑘) due to the 

transportation system. This measure is similar to 𝑅𝑅𝑠𝑠𝑠𝑠𝑠𝑠(𝑘𝑘)
𝑈𝑈  in that i t  compares the 

observed return probability to the hypothetical return probability if there had been no 

transportation. Like 𝑅𝑅𝑠𝑠𝑠𝑠𝑠𝑠(𝑘𝑘)
𝑈𝑈 ,  𝑅𝑅𝑎𝑎𝑎𝑎𝑎𝑎(𝑘𝑘)

𝑈𝑈  is suitable for untagged fish and uses transportation 

rates of untagged fish (i.e., 𝑡𝑡𝑖𝑖𝑈𝑈for juvenile site 𝑖𝑖). 

𝑅𝑅𝑎𝑎𝑎𝑎𝑎𝑎(𝑘𝑘)
𝑈𝑈 = �𝑆𝑆1 ∙∙∙ 𝑆𝑆𝑣𝑣�𝑆𝑆𝑣𝑣+1,𝑗𝑗𝑗𝑗

𝑤𝑤

𝑗𝑗=1

∙∙∙ 𝑆𝑆𝑘𝑘𝑘𝑘𝑘𝑘� �𝑅𝑅𝑠𝑠𝑠𝑠𝑠𝑠(𝑘𝑘)
𝑈𝑈 − 1�. (3.8) 

3.4.2 Differential Mortality 

Differential mortality, sometimes referred to as delayed mortality or delayed differential 

mortality, is the ratio of the post-Bonneville survival of transported fish to that of non-

transported fish. In particular, the measures reported by ROSTER give the ratio of post-

Bonneville survival to both site 𝐸𝐸 (the adult site that defines the extent of the 
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transportation effects) and to the final adult site for transported and non-transported fish. 

Differential mortality measures depend on the survival of transported smolts during 

transportation (i.e., on the barge or in the truck). The default barge transport survival is 

98%, but the user can change this value and enter a variance for barge survival on the 

Estimation tab of the program interface. See Section 2.5.2 for details. 

Just as there are many different types of transportation effect measures depending 

on the focus (site-specific or systemwide), nature of the control group (downstream 

transportation possible or not), and applicable population (tagged fish or untagged fish), 

there are the same types of measures of differential mortality. ROSTER provides 

estimates of five types of differential mortality measures: two systemwide measures (for 

tagged and untagged fish) and three site-specific measures (one isolated measure, one 

contextual measure for tagged fish, and one contextual measure for untagged fish). For 

each type, the differential mortality measure is reported for returns to site 𝑘𝑘 =  𝐸𝐸 and to 

the last adult site (𝑘𝑘 =  𝑣𝑣 +  𝑢𝑢). 

3.4.2.1 Site-specific differential mortality measures 

Like the differences among the site-specific transportation effect measures (𝑅𝑅𝑖𝑖(𝑘𝑘), 

𝑅𝑅𝑅𝑅𝑖𝑖(𝑘𝑘), and 𝑅𝑅𝑅𝑅𝑖𝑖(𝑘𝑘)
𝑈𝑈 ), mortality measures depend on the nature of the control group and on 

whether they are applicable to tagged or untagged fish. The three measures are 

described and defined in terms of the model parameters below. In each case, the 

subscript 𝑖𝑖 (𝑖𝑖 =  1,∙∙∙ , 𝑣𝑣) indicates the transport site (dam) being considered, and the 

subscript 𝑗𝑗 (𝑗𝑗 =  1,∙∙∙,𝑤𝑤) indicates the adult age class being used. The subscript 𝐸𝐸 (𝐸𝐸 =

 𝑣𝑣 +  1,∙∙∙ , 𝑣𝑣 +  𝑢𝑢) indicates the adult site to which transportation effects have been 

estimated (default is the first adult site), and 𝑘𝑘 indicates the adult site to which return 

probabilities have been calculated, with 𝑘𝑘 =  𝐸𝐸 or 𝑘𝑘 =  𝑣𝑣 +  𝑢𝑢. 

Isolated differential mortality (𝐷𝐷𝑖𝑖(𝑘𝑘)) 

The isolated differential mortality measure (𝐷𝐷𝑖𝑖(𝑘𝑘)) for juvenile site 𝑖𝑖 is the ratio of 

the return probability from Bonneville as a juvenile to adult site 𝑘𝑘 for site 𝑖𝑖 transport fish 

relative to that of fish passing site 𝑖𝑖 inriver, as if there were no further downstream 
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transportation sites. Like 𝑅𝑅𝑖𝑖(𝑘𝑘), the control fish for 𝐷𝐷𝑖𝑖(𝑘𝑘) are treated as if they had no 

possibility of being transported at sites downriver of site 𝑖𝑖. The measure 𝐷𝐷𝑖𝑖(𝑘𝑘) is valid for 

tagged and untagged fish: 

𝐷𝐷𝑖𝑖(𝑘𝑘) =
𝑅𝑅𝑖𝑖(𝑘𝑘) ∏ 𝑆𝑆𝑦𝑦𝑣𝑣

𝑦𝑦=𝑖𝑖+1

𝑆𝑆𝐵𝐵
, (3.9) 

where 𝑆𝑆𝐵𝐵 is the survival probability on the barge during transportation.  

Contextual differential mortality for tagged fish (𝐷𝐷𝐷𝐷𝑖𝑖(𝑘𝑘)) 

Contextual site-specific differential mortality for tagged fish (𝐷𝐷𝐷𝐷𝑖𝑖(𝑘𝑘)) for juvenile site 

𝑖𝑖 is the ratio of the return probability from Bonneville as a juvenile to adult site 𝑘𝑘 for site 

𝑖𝑖 transport fish relative to fish passing site 𝑖𝑖 inriver. Like 𝑅𝑅𝑅𝑅𝑖𝑖(𝑘𝑘), the control fish for 𝐷𝐷𝐷𝐷𝑖𝑖(𝑘𝑘) 

may be transported at sites downstream of site 𝑖𝑖. Also like 𝑅𝑅𝑅𝑅𝑖𝑖(𝑘𝑘), 𝐷𝐷𝐷𝐷𝑖𝑖(𝑘𝑘) is valid only for 

tagged fish because it depends on downstream transportation probabilities: 

𝐷𝐷𝐷𝐷𝑖𝑖(𝑘𝑘) =
𝑅𝑅𝑅𝑅𝑖𝑖(𝑘𝑘)

𝑆𝑆𝐵𝐵
�𝑆𝑆𝐵𝐵 � �𝑆𝑆𝑦𝑦𝑝𝑝𝑦𝑦𝑡𝑡𝑦𝑦 � 𝑆𝑆𝑙𝑙(1 − 𝑝𝑝𝑙𝑙𝑡𝑡𝑙𝑙)

𝑦𝑦−1

𝑙𝑙=𝑖𝑖+1

� + � 𝑆𝑆𝑙𝑙(1 − 𝑝𝑝𝑙𝑙𝑡𝑡𝑙𝑙)
𝑣𝑣

𝑙𝑙=𝑖𝑖+1

𝑣𝑣

𝑦𝑦=𝑖𝑖+1

� , (3.10) 

where 𝑆𝑆𝐵𝐵 is the survival probability on the barge during transportation. 

Contextual differential mortality for untagged fish (𝐷𝐷𝐷𝐷𝑖𝑖(𝑘𝑘)
𝑈𝑈 ) 

Contextual differential mortality for untagged fish (𝐷𝐷𝐷𝐷𝑖𝑖(𝑘𝑘)
𝑈𝑈 ) for juvenile site 𝑖𝑖 is 

analogous to 𝐷𝐷𝐷𝐷𝑖𝑖(𝑘𝑘) but is applicable to untagged fish (or to tagged fish if they had been 

treated as untagged). That is, under the assumption that tagged and untagged fish 

respond identically to transportation and have identical survival, then 𝐷𝐷𝐷𝐷𝑖𝑖(𝑘𝑘)
𝑈𝑈  is the ratio of the 

return probability from Bonneville (as a juvenile) to adult site 𝑘𝑘 for transport site 𝑖𝑖 fish to fish 

that passed site 𝑖𝑖 inriver. The control fish for 𝐷𝐷𝐷𝐷𝑖𝑖(𝑘𝑘)
𝑈𝑈  may be transported at dams downriver 

of site 𝑖𝑖. The rates at which the untagged control fish are transported at those sites are 

represented by the 𝑡𝑡𝑥𝑥𝑈𝑈 values for all juvenile dams 𝑥𝑥 >  𝑖𝑖. The values of  𝑡𝑡𝑥𝑥𝑈𝑈 may be 

entered by the user on the Estimation tab of the program interface or else be left at the 
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default values of either 1 or 0. 

𝐷𝐷𝐷𝐷𝑖𝑖(𝑘𝑘)
𝑈𝑈 =

𝑅𝑅𝑅𝑅𝑖𝑖(𝑘𝑘)
𝑈𝑈

𝑆𝑆𝐵𝐵
�𝑆𝑆𝐵𝐵 � �𝑆𝑆𝑦𝑦𝑝𝑝𝑦𝑦𝑡𝑡𝑦𝑦𝑈𝑈 � 𝑆𝑆𝑙𝑙(1 − 𝑝𝑝𝑙𝑙𝑡𝑡𝑙𝑙𝑈𝑈)

𝑦𝑦−1

𝑙𝑙=𝑖𝑖+1

� + � 𝑆𝑆𝑙𝑙(1 − 𝑝𝑝𝑙𝑙𝑡𝑡𝑙𝑙𝑈𝑈)
𝑣𝑣

𝑙𝑙=𝑖𝑖+1

𝑣𝑣

𝑦𝑦=𝑖𝑖+1

� , (3.11) 

where 𝑆𝑆𝐵𝐵 is the survival probability on the barge during transportation. 

3.4.2.2 Systemwide differential mortality measures 

Systemwide measures combine effects of transportation at all the transport dams 

in the system, comparing ocean return probabilities (to the extent of transportation 

effects) for all fish that were transported to all fish that were not transported. There is one 

measure for tagged fish and another measure for untagged fish (or for tagged fish had they 

been treated as untagged fish). 

Systemwide differential mortality for tagged fish (𝐷𝐷𝑠𝑠𝑠𝑠𝑠𝑠(𝑘𝑘)) 

𝐷𝐷𝑠𝑠𝑠𝑠𝑠𝑠(𝑘𝑘) =
(∏ 𝑆𝑆𝑖𝑖𝑣𝑣

𝑖𝑖=1 )�∑ ��∏ �1 − 𝑝𝑝𝑦𝑦𝑡𝑡𝑦𝑦�𝑖𝑖−1
𝑦𝑦=1 �𝑝𝑝𝑖𝑖𝑡𝑡𝑖𝑖𝑅𝑅𝑖𝑖(𝑘𝑘)�𝑣𝑣

𝑖𝑖=1 �
𝑆𝑆𝐵𝐵 ∑ ��∏ 𝑆𝑆𝑦𝑦�1 − 𝑝𝑝𝑦𝑦𝑡𝑡𝑦𝑦�𝑖𝑖−1

𝑦𝑦=1 �𝑆𝑆𝑖𝑖𝑝𝑝𝑖𝑖𝑡𝑡𝑖𝑖�𝑣𝑣
𝑖𝑖=1

, (3.12) 

where 𝑆𝑆𝐵𝐵 is survival on the barge during the transport.  

Systemwide differential mortality for untagged fish (𝐷𝐷𝑠𝑠𝑠𝑠𝑠𝑠(𝑘𝑘)
𝑈𝑈 ) 

𝐷𝐷𝑠𝑠𝑠𝑠𝑠𝑠(𝑘𝑘)
𝑈𝑈 =

(∏ 𝑆𝑆𝑖𝑖𝑣𝑣
𝑖𝑖=1 )�∑ ��∏ �1 − 𝑝𝑝𝑦𝑦𝑡𝑡𝑦𝑦𝑈𝑈�𝑖𝑖−1

𝑦𝑦=1 �𝑝𝑝𝑖𝑖𝑡𝑡𝑖𝑖𝑈𝑈𝑅𝑅𝑖𝑖(𝑘𝑘)�𝑣𝑣
𝑖𝑖=1 �

𝑆𝑆𝐵𝐵 ∑ ��∏ 𝑆𝑆𝑦𝑦�1 − 𝑝𝑝𝑦𝑦𝑡𝑡𝑦𝑦𝑈𝑈�𝑖𝑖−1
𝑦𝑦=1 �𝑆𝑆𝑖𝑖𝑝𝑝𝑖𝑖𝑡𝑡𝑖𝑖𝑈𝑈�𝑣𝑣

𝑖𝑖=1
, (3.13) 

where SB is the survival probability on the barge during transportation. 

3.4.3 Juvenile Survival 

Juvenile inriver survival (𝑆𝑆𝐽𝐽) is the probability of surviving from the first detection site 

(typically Lower Granite Dam) to the last juvenile detection site (typically Bonneville 

Dam) for non-transported fish. 
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𝑆𝑆𝐽𝐽 = �𝑆𝑆𝑖𝑖

𝑣𝑣

𝑖𝑖=2

. (3.14) 

3.4.4 Ocean Return Probabilities 

Ocean return probability for non-transported fish (𝑂𝑂𝑁𝑁𝑁𝑁) 

The measure 𝑂𝑂𝑁𝑁𝑁𝑁 is the probability of returning to the first adult detection site, 

conditional on reaching the last juvenile detection site as an inriver (non-transported) fish. 

The measure 𝑂𝑂𝑁𝑁𝑁𝑁 is valid for both tagged and untagged fish. 

𝑂𝑂𝑁𝑁𝑁𝑁 = �𝑆𝑆𝑣𝑣+1,𝑗𝑗𝑗𝑗

𝑤𝑤

𝑗𝑗=1

. (3.15) 

Ocean return probability for dam 𝑖𝑖 transported fish (𝑂𝑂𝑇𝑇𝑖𝑖) 

The measure 𝑂𝑂𝑇𝑇𝑖𝑖 is the probability of returning from juvenile site (or dam) 𝑖𝑖 to the 

first adult detection site, conditional on being transported at juvenile site 𝑖𝑖. The measure 

𝑂𝑂𝑇𝑇𝑖𝑖 represents the combination of barge survival, estuary and ocean survival, and 

maturation. This measure is valid for both tagged and untagged fish. 

𝑂𝑂𝑇𝑇𝑖𝑖 = 𝑆𝑆𝑖𝑖+1 ∙∙∙ 𝑆𝑆𝑣𝑣𝑅𝑅𝑖𝑖(𝑣𝑣+1) �𝑆𝑆𝑣𝑣+1,𝑗𝑗𝑗𝑗

𝑤𝑤

𝑗𝑗=1

. (3.16) 

3.4.5 Smolt-to-Adult Ratio 

Smolt-to-adult ratio for tagged f ish (𝑆𝑆𝑆𝑆𝑆𝑆) 

The measure 𝑆𝑆𝑆𝑆𝑆𝑆 is the probability of returning from the first juvenile detection site 

to the final adult site. This measure incorporates the proportion of smolts transported and 

transportation effects, as well as adult age structure. It is valid only for tagged fish. 

𝑆𝑆𝑆𝑆𝑆𝑆 = 𝑆𝑆2 ∙∙∙ 𝑆𝑆𝑣𝑣𝑅𝑅𝑠𝑠𝑠𝑠𝑠𝑠(𝑣𝑣+𝑢𝑢) ��𝑆𝑆𝑣𝑣+1,𝑗𝑗𝑗𝑗

𝑤𝑤

𝑗𝑗=1

∙∙∙ 𝑆𝑆𝑣𝑣+𝑢𝑢,𝑗𝑗𝑗𝑗�, (3.17) 
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where 𝑆𝑆𝑣𝑣+𝑢𝑢,𝑗𝑗𝑗𝑗 = 𝜆𝜆𝑗𝑗𝑗𝑗  under the assumption of 100% detection at the final detection site. 

Smolt-to-adult ratio for untagged fish (𝑆𝑆𝑆𝑆𝑆𝑆𝑈𝑈) 

The measure 𝑆𝑆𝑆𝑆𝑆𝑆𝑈𝑈 is the probability of an untagged fish returning from the first 

juvenile detection site (for tagged smolts) to the final adult site. As with other measures 

applicable to untagged fish, this value is appropriate only for untagged fish that are 

represented by the tagged group. This measure depends on the transportation 

proportions of untagged smolts at each transport dam, i.e., 𝑡𝑡𝑖𝑖𝑈𝑈 for juvenile site 𝑖𝑖. 

𝑆𝑆𝑆𝑆𝑆𝑆𝑈𝑈 = 𝑆𝑆2 ∙∙∙ 𝑆𝑆𝑣𝑣𝑅𝑅𝑠𝑠𝑠𝑠𝑠𝑠(𝑣𝑣+𝑢𝑢)
𝑈𝑈 ��𝑆𝑆𝑣𝑣+1,𝑗𝑗𝑗𝑗

𝑤𝑤

𝑗𝑗=1

∙∙∙ 𝑆𝑆𝑣𝑣+𝑢𝑢,𝑗𝑗𝑗𝑗�, (3.18) 

where 𝑆𝑆𝑣𝑣+𝑢𝑢,𝑗𝑗𝑗𝑗 = 𝜆𝜆𝑗𝑗𝑗𝑗  under the assumption of 100% detection at the final detection site. 

3.4.6 Adult Return Age Distribution 

Adult return age distribution for tagged fish (𝐴𝐴𝑗𝑗(𝑘𝑘)) 

The measures 𝐴𝐴𝑗𝑗(𝑘𝑘) indicate the proportions of adults returning to site 𝑘𝑘 (where 𝑘𝑘 =

 𝐸𝐸 or 𝑘𝑘 =  𝑣𝑣 +  𝑢𝑢) in each of the adult age classes (indexed by 𝑗𝑗 for  𝑗𝑗 =  1, … ,𝑤𝑤). These 

values incorporate transportation proportions and effects and so are suitable only for the 

tagged fish in the release group. For 𝑘𝑘 =  𝑣𝑣 +  𝑢𝑢, the parameter 𝑆𝑆𝑘𝑘𝑘𝑘𝑘𝑘  =  𝜆𝜆𝑗𝑗𝑗𝑗 under the 

assumption of 100% detection at the final adult detection site.  

𝐴𝐴𝑗𝑗(𝑘𝑘) = �
𝑆𝑆𝑣𝑣+1,𝑗𝑗𝑗𝑗 ∙∙∙ 𝑆𝑆𝑘𝑘𝑘𝑘𝑘𝑘

∑ 𝑆𝑆𝑣𝑣+1,𝑚𝑚𝑚𝑚 ∙∙∙ 𝑆𝑆𝑘𝑘𝑘𝑘𝑘𝑘
𝑤𝑤
𝑚𝑚=1

� × 

�∑ �𝑝𝑝𝑖𝑖𝑡𝑡𝑖𝑖𝑅𝑅𝑖𝑖𝑖𝑖(𝑘𝑘) ∏ �1 − 𝑝𝑝𝑦𝑦𝑡𝑡𝑦𝑦�𝑖𝑖−1
𝑦𝑦=1 �𝑣𝑣

𝑖𝑖=1 + ∏ (1 − 𝑝𝑝𝑖𝑖𝑡𝑡𝑖𝑖)𝑣𝑣
𝑖𝑖=1 �

𝑅𝑅𝑠𝑠𝑠𝑠𝑠𝑠(𝑘𝑘)
. (3.19) 

Adult return age distribution for untagged fish (𝐴𝐴𝑗𝑗(𝑘𝑘)
𝑈𝑈 ) 

The measures 𝐴𝐴𝑗𝑗(𝑘𝑘)
𝑈𝑈  are analogous to the 𝐴𝐴𝑗𝑗(𝑘𝑘) measures but for untagged smolts, 

representing the proportions of untagged adults (represented by the release group) 
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returning to site 𝑘𝑘 (where 𝑘𝑘 =  𝐸𝐸 or 𝑘𝑘 =  𝑣𝑣 +  𝑢𝑢) in each of the adult age classes 

(indexed by 𝑗𝑗 for  𝑗𝑗 =  1, … ,𝑤𝑤). These measures depend on the proportions of untagged 

smolts entering the bypass systems at transport dams that are transported, i.e., 𝑡𝑡𝑖𝑖𝑈𝑈 for 

juvenile site 𝑖𝑖. As with other measures for untagged fish, the direct inference for these 

values is to the tagged population had they been treated as untagged. For 𝑘𝑘 =  𝑣𝑣 +  𝑢𝑢, 

the parameter 𝑆𝑆𝑘𝑘𝑘𝑘𝑘𝑘  =  𝜆𝜆𝑗𝑗𝑗𝑗 under the assumption of 100% detection at the final adult 

detection site. 

𝐴𝐴𝑗𝑗(𝑘𝑘)
𝑈𝑈 = �

𝑆𝑆𝑣𝑣+1,𝑗𝑗𝑗𝑗 ∙∙∙ 𝑆𝑆𝑘𝑘𝑘𝑘𝑘𝑘
∑ 𝑆𝑆𝑣𝑣+1,𝑚𝑚𝑚𝑚 ∙∙∙ 𝑆𝑆𝑘𝑘𝑘𝑘𝑘𝑘
𝑤𝑤
𝑚𝑚=1

� × 

�∑ �𝑝𝑝𝑖𝑖𝑡𝑡𝑖𝑖𝑈𝑈𝑅𝑅𝑖𝑖𝑖𝑖(𝑘𝑘) ∏ �1 − 𝑝𝑝𝑦𝑦𝑡𝑡𝑦𝑦𝑈𝑈�𝑖𝑖−1
𝑦𝑦=1 �𝑣𝑣

𝑖𝑖=1 + ∏ (1 − 𝑝𝑝𝑖𝑖𝑡𝑡𝑖𝑖𝑈𝑈)𝑣𝑣
𝑖𝑖=1 �

𝑅𝑅𝑠𝑠𝑠𝑠𝑠𝑠(𝑘𝑘)
𝑈𝑈 (3.20) 

3.4.7 Adult Upriver Survival 

Adult upriver survival for tagged fish (𝑆𝑆𝐴𝐴)  

The measure 𝑆𝑆𝐴𝐴 is the survival from Bonneville (or the first adult site) to Lower 

Granite (or the last adult site) of all adults from the initial release group. This measure 

accounts for the proportions of smolts transported and the effects of transportation, as well 

as the adult return age distribution, but does not adjust for harvest or straying. It is suitable 

only for (tagged) fish in the release group. 

𝑆𝑆𝐴𝐴 =
∑ �𝑆𝑆𝑣𝑣+1,𝑗𝑗𝑗𝑗 ∙∙∙ 𝑆𝑆𝑣𝑣+𝑢𝑢,𝑗𝑗𝑗𝑗�𝑤𝑤
𝑗𝑗=1

∑ 𝑆𝑆𝑣𝑣+1,𝑚𝑚𝑚𝑚
𝑤𝑤
𝑚𝑚=1

𝑅𝑅𝑠𝑠𝑠𝑠𝑠𝑠(𝑣𝑣+𝑢𝑢)

𝑅𝑅𝑠𝑠𝑠𝑠𝑠𝑠(𝑣𝑣+1)
, (3.21) 

where 𝑆𝑆𝑣𝑣+𝑢𝑢,𝑗𝑗𝑗𝑗 =  𝜆𝜆𝑗𝑗𝑗𝑗 under the assumption of 100% detection at the final detection site. 

Adult upriver survival for untagged fish (𝑆𝑆𝐴𝐴𝑈𝑈) 

The measure 𝑆𝑆𝐴𝐴𝑈𝑈 is the survival from Bonneville (or the first adult site) to Lower 

Granite (or the last adult site) of untagged adults that are represented by the tagged 

release group. This measure accounts for the proportions of bypassed, untagged smolts 

transported (value 𝑡𝑡𝑖𝑖𝑈𝑈 for juvenile site 𝑖𝑖) as well as the effects of transportation and the adult 
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return age distribution but does not adjust for harvest or straying. 

𝑆𝑆𝐴𝐴𝑈𝑈 =
∑ �𝑆𝑆𝑣𝑣+1,𝑗𝑗𝑗𝑗 ∙∙∙ 𝑆𝑆𝑣𝑣+𝑢𝑢,𝑗𝑗𝑗𝑗�𝑤𝑤
𝑗𝑗=1

∑ 𝑆𝑆𝑣𝑣+1,𝑚𝑚𝑚𝑚
𝑤𝑤
𝑚𝑚=1

𝑅𝑅𝑠𝑠𝑠𝑠𝑠𝑠(𝑣𝑣+𝑢𝑢)
𝑈𝑈

𝑅𝑅𝑠𝑠𝑠𝑠𝑠𝑠(𝑣𝑣+1)
𝑈𝑈 (3.22) 

where 𝑆𝑆𝑣𝑣+𝑢𝑢,𝑗𝑗𝑗𝑗 =  𝜆𝜆𝑗𝑗𝑗𝑗 under the assumption of 100% detection at the final detection site. 

Age-specific adult upriver survival for tagged fish (𝑆𝑆𝐴𝐴𝐴𝐴) 

The measure 𝑆𝑆𝐴𝐴𝐴𝐴 is the survival from Bonneville (or the first adult site) to Lower 

Granite (or the last adult site) of all age-𝑗𝑗 adults from the initial release group, including 

transported and non-transported fish. This measure accounts for the proportions of smolts 

transported (value 𝑡𝑡𝑖𝑖 for juvenile site 𝑖𝑖) and the effects of transportation but does not adjust 

for harvest or straying. It is suitable only for (tagged) fish in the release group. 

𝑆𝑆𝐴𝐴𝐴𝐴 =
(∏ [1 − 𝑝𝑝𝑖𝑖𝑡𝑡𝑖𝑖]𝑣𝑣

𝑖𝑖=1 )�∏ 𝑆𝑆𝑖𝑖𝑖𝑖𝑖𝑖𝑣𝑣+𝑢𝑢
𝑖𝑖=𝑣𝑣+2 �  +  ∑ �𝑝𝑝𝑖𝑖𝑡𝑡𝑖𝑖𝑅𝑅𝑖𝑖𝑖𝑖�∏ [1 − 𝑝𝑝𝑙𝑙𝑡𝑡𝑙𝑙]𝑖𝑖−1

𝑙𝑙=1 ��∏ 𝑆𝑆𝑙𝑙𝑙𝑙𝑇𝑇𝑖𝑖
𝑣𝑣+𝑢𝑢
𝑙𝑙=𝑣𝑣+2 ��𝑣𝑣

𝑖𝑖=1

∏ [1 − 𝑝𝑝𝑖𝑖𝑡𝑡𝑖𝑖]𝑣𝑣
𝑖𝑖=1  +  ∑ �𝑝𝑝𝑖𝑖𝑡𝑡𝑖𝑖𝑅𝑅𝑖𝑖𝑖𝑖�∏ [1 − 𝑝𝑝𝑙𝑙𝑡𝑡𝑙𝑙]𝑖𝑖−1

𝑙𝑙=1 ��𝑣𝑣
𝑖𝑖=1

(3.23) 

where 𝑆𝑆𝑣𝑣+𝑢𝑢,𝑗𝑗𝑗𝑗 =  𝜆𝜆𝑗𝑗𝑗𝑗  and 𝑆𝑆𝑣𝑣+𝑢𝑢,𝑗𝑗𝑇𝑇𝑖𝑖 = 𝜆𝜆𝑗𝑗𝑇𝑇𝑖𝑖 under the assumption of 100% detection at the 

final detection site. 

Age-specific adult upriver survival for untagged fish (𝑆𝑆𝐴𝐴𝐴𝐴𝑈𝑈 ) 

The measure 𝑆𝑆𝐴𝐴𝐴𝐴𝑈𝑈  is the survival from Bonneville (or the first adult site) to Lower Granite 

(or the last adult site) of all untagged age-𝑗𝑗 adults represented by the initial release group, 

including transported and non-transported fish. This measure accounts for the proportions 

of smolts transported (value 𝑡𝑡𝑖𝑖𝑈𝑈 for juvenile site 𝑖𝑖) and the effects of transportation but does 

not adjust for harvest or straying.  

𝑆𝑆𝐴𝐴𝐴𝐴𝑈𝑈 =
�∏ [1 − 𝑝𝑝𝑖𝑖𝑡𝑡𝑖𝑖𝑈𝑈]𝑣𝑣

𝑖𝑖=1 ��∏ 𝑆𝑆𝑖𝑖𝑖𝑖𝑖𝑖𝑣𝑣+𝑢𝑢
𝑖𝑖=𝑣𝑣+2 �  +  ∑ �𝑝𝑝𝑖𝑖𝑡𝑡𝑖𝑖𝑈𝑈𝑅𝑅𝑖𝑖𝑖𝑖�∏ [1 − 𝑝𝑝𝑙𝑙𝑡𝑡𝑙𝑙𝑈𝑈]𝑖𝑖−1

𝑙𝑙=1 ��∏ 𝑆𝑆𝑙𝑙𝑙𝑙𝑇𝑇𝑖𝑖
𝑣𝑣+𝑢𝑢
𝑙𝑙=𝑣𝑣+2 ��𝑣𝑣

𝑖𝑖=1

∏ [1 − 𝑝𝑝𝑖𝑖𝑡𝑡𝑖𝑖𝑈𝑈]𝑣𝑣
𝑖𝑖=1  +  ∑ �𝑝𝑝𝑖𝑖𝑡𝑡𝑖𝑖𝑈𝑈𝑅𝑅𝑖𝑖𝑖𝑖�∏ [1 − 𝑝𝑝𝑙𝑙𝑡𝑡𝑙𝑙𝑈𝑈]𝑖𝑖−1

𝑙𝑙=1 ��𝑣𝑣
𝑖𝑖=1

(3.24) 

where 𝑆𝑆𝑣𝑣+𝑢𝑢,𝑗𝑗𝑗𝑗 =  𝜆𝜆𝑗𝑗𝑗𝑗 and 𝑆𝑆𝑣𝑣+𝑢𝑢,𝑗𝑗𝑇𝑇𝑖𝑖 = 𝜆𝜆𝑗𝑗𝑇𝑇𝑖𝑖 under the assumption of 100% detection at the 

final detection site.  
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4.0 Fitting ROSTER and Model 
Selection 

4.1 Guidance on Fitting ROSTER 

In most cases, the default model provided by ROSTER should be sufficient to 

analyze the data. In some cases, however, the user may need to modify the model file in 

order to properly fit the model to the data. Below are some suggestions on using 

ROSTER. These steps require familiarity with the format of the model file; see Chapter 

7 for an example of a model file. 

1. Begin by loading the file with all the age classes observed. 

2. Try running the default model with the value in the Extent of Transportation 
Effects window set to the first adult site (e.g., 7 if there are 6 juvenile sites). 

3. If the model in step 2 does not fit, then it is necessary to edit the model file. Save 

the model file as either an .xml or a .txt document (under the File menu, Save 
Model Definition), then open and edit the model file. The necessary edits will 

depend on the data set. Some common changes are described here. 

a. Examine the Parameters report, which lists the default initial values that 

ROSTER uses (the MoM estimates). If any of the MoM estimates other than 

for the T/I parameters (𝑅𝑅𝑖𝑖𝑖𝑖) are equal to 1, 0, or “inf” (∞), then the default 

model file or the data file will need to be modified as follows: 

i. Detection parameters (𝑝𝑝𝑖𝑖𝑖𝑖, 𝑝𝑝𝑖𝑖𝑖𝑖𝑖𝑖, 𝑝𝑝𝑖𝑖𝑖𝑖𝑇𝑇𝑘𝑘) and “last reach” parameters (𝜆𝜆𝑗𝑗𝑗𝑗 or 

𝜆𝜆𝑖𝑖𝑖𝑖𝑇𝑇𝑘𝑘) that are very high (e.g., 1 or above) cannot be easily estimated and 

so must be fixed in the model file. Rather than fixing them to 1, they should 

be fixed to a value very close to 1, such as 0.999999. 

ii. Survival parameters (𝑆𝑆𝑖𝑖𝑖𝑖, 𝑆𝑆𝑖𝑖𝑖𝑖𝑖𝑖, 𝑆𝑆𝑖𝑖𝑖𝑖𝑇𝑇𝑘𝑘) that are equal to 1 or very close to 1 
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may need to be fixed to 1. In general, ROSTER can estimate these 

parameters, but the particular structure of the data may make this 

impossible. Try fitting the model both with and without these very high 

survival parameters fixed to 1 or 0.999999. If possible, it is preferable to 

leave these parameters free (not fixed), but in some cases that option may 

not work. 

iii. If the MoM estimate for a detection parameter is equal to 0, that means 

that this parameter cannot be estimated for this data set; it is not 

necessarily the case that there was no detection at the particular site, but 

may be the case that no fish detected at the site were also detected at a 

later site. Rather than modifying the model file, it is necessary to remove 

the field corresponding to that detection site from the data file. To do this, it 

is necessary to run the raw PTAGIS data files through PitPro again, 

omitting the problematic detection site. If the problematic detection site is 

the first or last juvenile or adult site, then the meaning of the performance 

measures 𝑆𝑆𝐽𝐽 (juvenile survival) or 𝑆𝑆𝐴𝐴 (adult survival), respectively, as well 

as 𝑆𝑆𝑆𝑆𝑆𝑆, will be altered. 

iv. If the MoM estimate for a survival parameter is either 0 or “inf,” it is likely 

that the detection parameter for an adjacent site cannot be estimated. 

Check if a detection parameter has 0 for its MoM estimate; if so, remove 

the detection site from the data file by running the data through PitPro again, 

reload the modified capture history file into ROSTER, and try fitting the 

default model again. 

v. If the MoM estimate for a parameter is “nan,” then it may be necessary to 

specify a numeric initial value (seed) for the parameter in the model file; see 

Section 5.4 for examples. 

b. If the model still does not fit following the edits described here, then examine 

the Data Summary report and note the sizes of the observed age classes. Age 

classes with very few detections will be difficult to analyze and may need to 
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be removed. This can be done by: 

i. Censoring the capture histories of fish observed in these age classes, with the 

censoring occurring at the final juvenile site at the which the fish was 

detected. 

ii. Alternatively, the detections in the problematic age class can be recoded 

to fall in an adjacent age class (i.e., two age classes are collapsed to one). 

This option is not ideal because age classes cannot properly be collapsed 

unless there is no difference in adult upstream parameters between the two 

age classes. However, because adult detection and survival estimates are 

often very high, it may be logical to collapse two adult age classes. 

iii. Remove from the data file the capture histories of the fish detected in the 

problematic age class. This option is reasonable only if there are very few 

fish to be removed (e.g., 1 or 2), because it may bias results. 

4. If the model in one of the above steps fits, then it may be worthwhile to explore a 

more flexible model structure. 

a.  Try using different detection or censoring probabilities for all transport groups 

(including non-transported or control fish) for the first adult site. This can be done 

by deleting the section of the model file that equates these parameters. Note 

that if any of these parameters were fixed to a particular value (e.g., 0 or 

0.999999), then this must be adjusted if the parameters are allowed to differ. 

b. If the model in step 4a fits, then try increasing the site identified as the extent 

of transportation effects. This is most easily done by selecting the default model 

to be used, increasing the number in the Extent of Transportation Effects 

window, loading the model, and then saving and editing the model as described 

above, if necessary. Alternatively, the expert user may alter the edited model 

file so that transport and non-transport groups have separate adult parameters 

up to the adult site that is identified as the extent of transportation effects. It 

may also be interesting to distinguish among groups transported at different 
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sites. 

It is generally not necessarily for the user to pick initial values (seeds) for ROSTER, 

because ROSTER calculates the MoM estimates to use as seeds. However, the user may 

select a different seed if desired and adjust the model file accordingly. An example of how 

to do this is shown at the end of Chapter 5. 

4.2 Model Selection 

In most cases, models with different structures will fit the data. For example, some 

models may equate certain parameters that are left unique in other models. In general, the 

“best” model captures all valid differences among parameters without unnecessarily 

estimating separate values for parameters that are effectively equal. 

There are several tools that may be used to select the best model, including LRT 

and AIC. Additionally, common sense should be used in determining whether it is really 

necessary to estimate unique values for a set of parameters. 

4.2.1 Likelihood Ratio Tests 

Likelihood Ratio Tests are statistical tests used to compare two models in which 

one model is “nested” within the other. The model nested in the other may be considered 

a special case of the more general model. The more general (“full”) model typically has 

more parameters than the special case (“reduced model”) or estimates separate values 

for parameters that are equated in the reduced model. The null hypothesis for an LRT is 

that the two models are equivalent, in which case the reduced model should be used. 

Program ROSTER provides the information necessary to perform an LRT between 

two nested models. If Model 1 is nested within Model 2, then the user fits both Model 1 

and Model 2 in ROSTER and notes the final function value for each model. Let 𝐹𝐹𝐹𝐹1 be 

the function value for Model 1 (the reduced model), and 𝐹𝐹𝐹𝐹2 be the function value for 

Model 2 (the full model). Because Model 2 is more general than Model 1, 𝐹𝐹𝐹𝐹2  ≤  𝐹𝐹𝐹𝐹1. 

The LRT test statistic is 
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𝑋𝑋 = 2(𝐹𝐹𝐹𝐹1 − 𝐹𝐹𝐹𝐹2). (4.1) 

Define 𝑑𝑑 to be the difference in the number of parameters between Models 1 and 2. 

For a Type I error of size 𝛼𝛼, compare 𝑋𝑋 to 𝜒𝜒𝑑𝑑,1−𝛼𝛼
2 , the upper 100 × (1 −  𝛼𝛼) percentile 

point from the chi-square distribution with 𝑑𝑑 degrees of freedom. If 𝑋𝑋 > 𝜒𝜒𝑑𝑑,1−𝛼𝛼
2 , then reject 

the null hypothesis and use the full model (Model 2). Otherwise, use the reduced model 

(Model 1). 

For example, the sample data set 𝐝𝐝𝐝𝐝𝐝𝐝𝐝𝐝𝐝𝐝. 𝐭𝐭𝐭𝐭𝐭𝐭 (found on the ROSTER page on the 

CBR website) has three transportation sites and two adult detection sites. We can 

estimate transportation effects for the three transportation sites, but where do those effects 

end? At the first adult site (Bonneville), or at the second adult site (Lower Granite)? We 

can fit models with either assumption by setting the extent of transportation effects to 

either 7 or 8 and loading and running the default model. Let the model with transportation 

effects ending at site 7 be Model 1, and the model with transportation effects ending at site 

8 be Model 2. The difference between these two models is that in Model 2, the adult 

detection and censoring parameters at site 7, and the “last reach” lambda parameters, 

are estimated separately for transported fish and non-transported fish (within each age 

class), while in Model 1, these parameters are equated for transported and non-

transported groups. The model equating these parameters (Model 1) is the reduced 

model, while the model estimating unique parameters for transported fish (Model 2) is 

the full model. The full model yields a negative log-likelihood value of 𝐹𝐹𝐹𝐹2  =

 478537.60088236 with 47 parameters, and the reduced model yields a negative log-

likelihood value of 𝐹𝐹𝐹𝐹1  =  478551.17171487 with 40 parameters. This gives the LRT test 

statistic 𝑋𝑋 =  27.14167 with 𝑑𝑑 =  7 and critical value 𝜒𝜒7,0.95
2 = 14.6714 for 𝛼𝛼 = 0.05. 

Because 𝑋𝑋 > 𝜒𝜒7,0.95
2 , we reject the null hypothesis that adult parameters are the same for 

transported and non-transported fish, and Model 2 should be used. 

4.2.2 Akaike’s Information Criterion 

Models that are not nested cannot be compared using likelihood ratio tests. For 

example, consider comparing two models that are identical except in how they handle 

https://www.cbr.washington.edu/analysis/apps/roster
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adult detection probabilities at the first adult site. Model 1 equates these detection 

probabilities across all transport groups and the non-transport group, while Model 2 specifies 

unique values for the transport and non-transport groups. So far, Model 1 is nested within 

Model 2, and model selection could be performed using an LRT. Suppose, however, 

that the detection probability for the first age class of the non-transport group was 100%, 

but for the first age class of the transported fish, it was smaller, say 80%. In this case, 

Model 2 would need to fix the detection probability for the first age class of the non-

transport group to 1 but leave the comparable parameter for the transport group free. 

Because the parameter for the non-transport group is fixed in Model 2 but not in Model 1, 

Model 1 is not nested in Model 2, and model selection cannot be done via LRTs. 

Instead, we can use AIC, which is based on likelihood values and the number of 

parameters in each model. The AIC is not a formal test and should not be used to 

compare models with widely different likelihood structures but is a reasonable tool for 

model selection in ROSTER. The AIC can be used to compare nested models as well, 

but in general it is better to use LRTs in such a case. 

To compare models using AIC, calculate the AIC value for each model and select 

the model with the smaller AIC. As with the LRT defined in Section 4.2.1, let 𝐹𝐹𝐹𝐹𝑖𝑖 be the 

ROSTER function value for Model 𝑖𝑖 (here, 𝑖𝑖 = 1 or 2). Also, let 𝐾𝐾𝑖𝑖 be the number of 

parameters estimated in Model 𝑖𝑖. The number of parameters estimated is listed near the 

top of the Estimation Results report. Then the AIC for Model 𝑖𝑖 is 

𝐴𝐴𝐴𝐴𝐴𝐴𝑖𝑖 = 2𝐹𝐹𝐹𝐹𝑖𝑖 + 2𝐾𝐾𝑖𝑖 . (4.2) 

As an example, consider the models in Section 4.2.1. Although these models are 

nested, it is still possible to compare them via AIC. Model 1 had a function value of 𝐹𝐹𝐹𝐹1 

=  478551.17171487 and 𝐾𝐾1 =  40 parameters, with an AIC of 𝐴𝐴𝐴𝐴𝐴𝐴1 =  957182.3. Model 2 

had a function value of 𝐹𝐹𝐹𝐹2 =  478537.60088236 with 𝐾𝐾2 =  47 and an AIC of 𝐴𝐴𝐴𝐴𝐴𝐴2 =

 957169.2. Because 𝐴𝐴𝐴𝐴𝐴𝐴2 <  𝐴𝐴𝐴𝐴𝐴𝐴1, Model 2 is favored over Model 1, as indicated by the 

LRT. 
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5.0 Model Definition File Format 

The model definition file created by ROSTER conforms to Extensible Markup 

Language (xml) 1.0. The model definition file can be modified using an xml editor or any 

other text editor. All terminology used in the following, such as tag, element, and 

attribute, is from the xml 1.0 specification. 

Typically, a custom model definition may be created by using ROSTER to save the 

default model definition to a file. This file can then be used as a starting point and edited 

to create a new model definition. The first line of the file must be: 

<? xml version = "1.0" encoding = "UTF− 8" standalone = "no" ? > 

The root element must be roster. The allowable child elements are 

• validate 

• fix 

• equate 

• initialSeeds 

These top-level elements can appear in any order in the file. 

5.1 Validate Element 

The validate element is not actually a part of the model definition but gives 

ROSTER the ability to determine if the model definition is appropriate for the data set 

currently loaded. 

The validate tag must be specified once in the model definition file. The tag takes 

no attributes and there are three required child elements, each of which must occur once (in 

any order). 

• juvenileSites 

http://www.w3.org/xml
http://www.w3.org/xml
http://www.w3.org/xml
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• adultSites 

• ageClasses 

They specify the number of juvenile detection sites, the number of adult detection 

sites, and the number of age classes, respectively. The content for each must be a 

positive integer number. The following model definition fragment specifies that the model is 

defined for data with six juvenile detection sites, four adult detection sites, and two age 

classes. 

<? xml version = "1.0" encoding = "UTF− 8" standalone = "no" ? > 

. . . 

< validate > 

< juvenileSites > 6 </juvenileSites > 

< adultSites > 4 </adultSites > 

< ageClasses > 2 </ageClasses > 

</validate > 

. . . 

5.2 Fix Element 

The fix element allows a parameter to be removed from the model and replaced 

by a fixed constant. It has one required attribute, value, which takes a decimal number 

for its value. The fix element requires one or more param elements that have a parameter 

name as their content. The following fragment replaces two parameters with the 

constant “1.0.” 

. . . 

< fix value = "1.0" > 

< param > R11 </param > 

< param > R12 </param > 

</fix > 
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. . . 

5.3 Equate Element 

The equate element allows two or more parameters to be represented by a single 

parameter in the model. The tag takes no attributes and requires two or more param 

elements as described above for the fix element. The following fragment causes three 

model parameters to be represented by a single parameter: 

. . . 

< equate > 

< param > sC711 </param > 

< param > sC712 </param > 

< param > sC713 </param > 

</equate > 

. . . 

5.4 InitialSeeds Element 

The initialSeeds element is used to specify initial parameter seeds to be used 

instead of the default seeds. It allows only one child element: “seed,” which may occur 

one or more times. 

The seed element requires two child elements that must each occur once in any 

order: param and value. The following will cause ROSTER to use 0.7 as the initial seed 

for the parameter 𝑠𝑠1, and 0.9 as the initial seed for the parameter 𝑝𝑝𝑝𝑝83. 

. . . 

< initialSeeds > 

< seed > 

< param > s1 </param > 

< value > 0.7 </value > 



53  

</seed > 

< seed > 

< param > pC83 </param > 

< value > 0.9 </value > 

</seed > 

</initialSeeds > 

. . . 
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6.0 Data Sources 

The primary source of the PIT-tag data to be used with ROSTER is detections in 

juvenile bypass systems and adult fish ladders at dams on the Columbia and Snake 

rivers. These data may be downloaded from the Pacific States Marine Fisheries 

Commission PTAGIS database and formatted for ROSTER using the University of 

Washington’s PIT-tag processing software PitPro. It is also possible to use spawning 

grounds or hatcheries as the first and/or last detection sites, as long as detection effort is 

constant throughout the period when the tagged fish are either leaving or arriving at 

those sites, respectively. Only a single spawning ground location or hatchery should be 

used as the first detection site. Multiple spawning grounds and hatcheries may be used 

as the final field in PitPro, resulting in data pooled across location for the final detection 

site. 

The model used in Program ROSTER is appropriate for spring and summer Chinook 

salmon, Sockeye salmon, and Steelhead. Because the model does not accommodate 

the overwintering behavior of fall Chinook salmon, data from this species should not be 

analyzed with Program ROSTER. 

6.1 Lower Granite Dam: Spillway Detections 

Detections of PIT tags have been available from the Removable Spillway Weir 

(RSW) at Lower Granite Dam since 2020 and may be available at other dams in the 

future. Currently, it is not advised to use spillway detections with ROSTER because the 

model assumes that all detected tags have the same opportunity for either censoring or 

removal for transport, whereas smolts passing over the spillway have zero probability of 

both such events. Future versions of ROSTER are planned to incorporate RSW 

detections at Lower Granite Dam. 

6.2 Estuary Detections 

Detections of PIT tags are available from several sources in the Columbia River 

https://www.cbr.washington.edu/analysis/apps/pitpro
https://www.cbr.washington.edu/analysis/apps/pitpro
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estuary, including the towed array (code TWX in PTAGIS), the experimental trawl, and 

various pile dikes. These data have been used elsewhere to estimate juvenile survival 

to the Bonneville tailrace and may allow for direct comparison of post-Bonneville survival 

of transported and non-transported individuals. However, there are several practical 

considerations that preclude using estuary observations in ROSTER at this time. First, 

detection probabilities in the estuary are typically very low, with <  1% to 4% of tagged 

fish previously detected at Bonneville subsequently detected at the towed array in 

recent years. This means that the standard errors on survival estimates based on 

estuary detections will be large and the estimation routine may have difficulty fitting the 

model because of the very small detection probabilities. Second, the model used in 

ROSTER assumes that there is no juvenile detection site downstream of the release 

site of transported fish. Thus, estuary observations will appear to be adult detections, 

and the transport-inriver ratio parameters (𝑅𝑅𝑖𝑖𝑖𝑖) will reflect the relative effect of 

transportation on survival only to the towed array, rather than to the first adult site. Also, 

the performance measures will report “ocean” survival only to the estuary as juveniles 

(towed array), rather than to the first adult site. Thus, ROSTER is not currently designed 

to incorporate estuary observations. Future versions of ROSTER may add this 

capability. 

6.3 Avian Predation Data: Detections From Bird Colonies 

Using PIT-tag detections from bird colonies in ROSTER is appealing because it 

would provide extra detection sites and potentially help identify and quantify sources of 

mortality; however, use of such data is inappropriate for ROSTER. It is problematic to use 

detections from mid-Columbia bird colonies (e.g., Crescent Island) due to uncertainty 

about location of the predation event (e.g., upstream or downstream of McNary Dam). 

Misspecification of the reach where predation occurred may result in biased estimates of 

reach survival. Detections from avian colonies downstream of Bonneville Dam are 

inappropriate for use in ROSTER for the same reasons that detections from the towed 

array, experimental trawl, and pile dikes are inappropriate: these detections will be 

viewed as adult detections and transportation parameters and performance measures will 
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be inappropriately estimated. Thus, it is inappropriate to use avian predation detections 

with ROSTER at this time. 

6.4 Harvest Data 

Migrating adults pass through several fisheries in the lower Columbia River, in 

particular the Zone 5 and Zone 6 fisheries. Incorporating harvest rates from these fisheries 

would help identify sources of mortality and provide tools to explore effects of different 

harvest management strategies. If harvest rate estimates are independently known, it is 

possible to adjust reach survival estimates to reflect only non-harvest mortality. If harvest 

rates are unknown, however, it is impossible to adjust for harvest, even with PIT-tag 

recoveries from the fisheries, unless the tag recovery rate is also known. Without an 

estimate of the tag recovery rate, it is impossible to separate the harvest rate from the 

tag recovery rate. Thus, data from PTAGIS alone are insufficient for incorporating 

harvest data into ROSTER. 
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7.0 Sample Data Sets 

Two sample data sets are included with ROSTER. The first data set (data1.txt) 
contains PIT-tag detection history data from hatchery-raised spring Chinook salmon 

(Oncorhynchus tshawytscha) released in the Snake River Basin upstream of Lower Granite 

Dam in 1999. The second data set (data2.txt) contains PIT-tag detection histories from 

hatchery-raised spring Chinook salmon released in the Snake River upstream of Lower 

Granite Dam in 2002. For both data sets, release and detection data were obtained from 

the PTAGIS database maintained by the Pacific States Marine Fisheries Commission and 

formatted for ROSTER by UW software PitPro. Here, the steps required to fit the 

ROSTER model to these data sets are shown. 

7.1 Example 1: 1999 Spring Chinook Salmon 

For this example, you can find the data set data1.txt on the ROSTER page on the 

CBR website. 

Records were available for 𝑁𝑁 =  178,260 spring Chinook salmon. Juvenile 

detections were available from Lower Granite (LGR), Little Goose (LGO), Lower 

Monumental (LMO), McNary (MCN), John Day (JD), and Bonneville (BON) dams. Adult 

detections were available in the years 2000, 2001, and 2002 from the adult fish ladders at 

Bonneville and Lower Granite dams. Fish were transported from LGR, LGO, and LMO. 

To load this data set into ROSTER, download the file from the ROSTER webpage, 

save it to wherever you keep your data files, enter the file’s location settings on the Data 

tab as shown in Figure 2.1, and click the Load button. After loading the data, the Data 
Summary is available from the Reports menu. Figure 7.1 shows the first part of the 

Data Summary output. 

The default model is sufficient for this data set. Set the model definition settings as 

shown in Figure 2.2. The value in the Extent of Transportation Effects window should 

be set to 7 (the first adult site). Click the Load button to load the default model. For 

https://cbr.washington.edu/analysis/apps/roster
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future reference, refer to this model as Model 1.1.  

Before running the estimation routine, it may be useful to examine the structure of 

the default model file (also see Section 5). The model file is in Extensible Markup 

Language (XML) format; hence, the default file extension is . 𝐱𝐱𝐱𝐱𝐱𝐱. Click on Save Model 
Definition... under the File menu and save the file; this is replicated as 𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦_𝟏𝟏. 𝐱𝐱𝐱𝐱𝐱𝐱 

on the ROSTER webpage. Open the saved model file using an appropriate .xml editor or 

any .txt editor.  

 

Figure 7.1. The top portion of the Data Summary report for the first sample data set 

(data1.txt). 
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There are several types of code in the default model file. After the heading comes a 

section where certain adult parameters are equated (Figure 7.2). The first set of 

parameters equated are the detection parameters at (adult) site 7 for age class 1. There 

are seven parameters listed as equated, referring to the seven possible treatment 

groups: “control” (𝑝𝑝𝑝𝑝71) and transport groups from each of the six juvenile dams (𝑝𝑝𝑝𝑝711 

through 𝑝𝑝𝑝𝑝716). The naming of model parameters for the adult portion of ROSTER follows 

a convention. The first character (here, 𝑝𝑝) indicates the type of parameter (𝑝𝑝 = detection 

probability, 𝑐𝑐 = censoring probability, and 𝑠𝑠 = survival probability). The second 

character indicates the treatment group the parameter describes (𝐶𝐶 = control or non-

transported, 𝑇𝑇 = transported). The third character is a number indicating the detection 

site; recall that detection sites are numbered consecutively, so if there are six juvenile sites, 

then “7” indicates the first adult site. The fourth character is a number indicating the 

adult (or ocean) age class, typically 1, 2, or 3. If the parameter is for a transport group, 

then there will be a fifth character indicating the transport site. Thus, 𝑝𝑝𝑝𝑝713 is the 

detection probability at site 7 for age class 1 fish that were transported at site 3 as 

juveniles. In order to incorporate the maximum amount of flexibility, ROSTER names 

parameters for transport groups for all juvenile sites, even those that are not transport 

dams. For example, the file 𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦_𝟏𝟏. 𝐱𝐱𝐱𝐱𝐱𝐱 shows parameters 𝑝𝑝𝑝𝑝714, 𝑝𝑝𝑝𝑝715, and 

𝑝𝑝𝑝𝑝716 even though sites 4, 5, and 6 (McNary, John Day, and Bonneville, respectively) 

were not transport sites. However, these parameters for non-existent transport groups are 

not actually used in fitting the model, so the user may ignore them. In general, it is safest 

to keep them equated to the “control” parameters (e.g., 𝑝𝑝𝑝𝑝71) in the model definition file. 
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Figure 7.2. The top part of the default model file (𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦_𝟏𝟏. 𝐱𝐱𝐱𝐱𝐱𝐱 ) for the first sample data 

set. 

The default model in file 𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦_𝟏𝟏. 𝐱𝐱𝐱𝐱𝐱𝐱 shows that adult detection and censoring 

parameters are equated across transport and non-transport groups for detection site 7 and 

all age classes, and that the “last reach” (lambda) parameters are also equated for each 

age class. Figure 7.3 shows the next section of code, where certain parameters are fixed 

to either 0 or 1. In particular, transportation parameters for non-transport sites (sites 4, 

5, and 6) are fixed to 0, as are adult censoring parameters for sites and age classes where 

no adult censoring occurred. T/I parameters (𝑅𝑅𝑅𝑅𝑅𝑅) are fixed to 1 for sites 𝑖𝑖 for which there 

was no transportation. Next is a line indicating the extent of transportation effects entered 

on the ROSTER interface (i.e., 7), followed by the values for the parameters set by the 

user (barge survival and untagged transport parameters). Last is a necessary section 

showing the number of juvenile and adult sites, and the number of adult age classes. The 

model will not load correctly if this section or the transportation effects extent line is 
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missing. 

.  

Figure 7.3. The bottom part of the default model file (𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦_𝟏𝟏. 𝐱𝐱𝐱𝐱𝐱𝐱 ) for the first sample 

data set. 

Having examined the different parts of the default model, run the estimation routine: 

click the Estimate Parameters button on the Estimation tab. The message window 
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should indicate that the estimation completed after about 53 iterations, and the 

Estimation Results report should open. Figure 7.4 shows the first portion of the 

Estimation Results window. 

 

Figure 7.4. The top portion of the Estimation Results output for the first sample data set 

(𝐝𝐝𝐝𝐝𝐝𝐝𝐝𝐝𝐝𝐝. 𝐭𝐭𝐭𝐭𝐭𝐭), analyzed with the default model and extent of transportation effects set to 7. 
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Parameters that were fixed (not estimated) in the default model (e.g., 

transportation parameters for non-transport sites: 𝑡𝑡4, 𝑡𝑡5, and 𝑡𝑡6) show the value to which 

they were fixed and have NA as their standard error. In general, any parameter with 

standard error shown as NA was not estimated. The performance measure estimates are 

shown after the model parameter estimates, first with jacks included and then excluding 

jacks. ROSTER reports transportation effect measures and differential mortality measures 

on adult returns to two sites: the adult site that is the extent of the transportation effects 

used in the model (site 𝐸𝐸) and the final adult site. In this case, these sites are site 7 

(BON) and site 8 (LGR), respectively. The performance measure estimates using return 

rates to the different sites are slightly different but not significantly (Figure 7.5). 

 

Figure 7.5. Part of the performance measure estimates in the Estimation Result report for 

the first sample data set (data1.txt), analyzed with the default model and Extent of 
Transportation Effects set to 7. 
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Now fit the model with transportation effects extended to the second and final adult 

site. On the Estimation tab of the ROSTER interface, change the value in the Extent of 
Transportation Effects window to 8, and click the Load button. For future reference, 

refer to this model as Model 1.2. Before running the estimation routine, save the model file 

and examine its structure. This model file is replicated as 𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦_𝟐𝟐. 𝐱𝐱𝐱𝐱𝐱𝐱 on the 

ROSTER webpage. Notice that in this model file, the adult parameters for the non-

transported fish (e.g., 𝑝𝑝𝑝𝑝71 along with 𝑝𝑝𝑝𝑝714, 𝑝𝑝𝑝𝑝715, and 𝑝𝑝𝑝𝑝716) are equated, while the 

parameters for transported fish (e.g., 𝑝𝑝𝑝𝑝711, 𝑝𝑝𝑝𝑝712, and 𝑝𝑝𝑝𝑝713) are equated separately. 

This model estimates different detection, censoring, and lambda parameters for 

transported fish compared to non-transported fish. 

Return to the Estimation tab and click on Estimate Parameters. After 64 

iterations, the estimation routine should be complete and a new Estimation Results report 

should open. In the results report for this model, notice that the adult detection and 

censoring parameters at site 7 and the lambda parameter are reported separately for non-

transported fish and for each transport group. However, the values are the same among 

all the transport groups. This is because the default model equates adult parameters 

among the transport groups but distinguishes between transported and non-transported 

fish, up until the site that is defined as the extent of transportation effects. In this case, the 

extent of transportation effects is the last adult site, so all adult parameters are estimated 

separately for transported and non-transported fish. Also notice that the transportation 

effect and differential mortality performance measures are now reported only to site 8, 

because this site is both the extent of transportation effects and the final adult site. 

It may be reasonable to expect that the lambda parameters will be smaller for 

transported fish than for non-transported if transported fish have higher straying rates and 

thus lower perceived adult survivals. This appears to be the case in two of the three age 

classes, although the differences are not significant. However, it seems less likely that 

transported and non-transported fish would have different detection and censoring 

probabilities at the adult sites. Thus, it may be useful to explore a model that estimates 

unique lambda parameters for transported and non-transported fish but common 

detection and censoring parameters. This is not the structure of the default model, so it 
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is necessary to modify a model definition file. With the extent of transportation effects set 

to 8 and the default model loaded, click on Save Model Definition... under the File menu 

to save the file. Open the file using the appropriate software and edit it so that all the 

detection and censoring parameters are equated within each age class. Also, remove 

the parameters 𝑐𝑐𝑐𝑐711 and 𝑐𝑐𝑐𝑐731 from the list of parameters set to 0. Save the model as 

Model 1.3, select Model Definition File on the ROSTER interface, select the model just 

saved, and Load the model. Alternatively, use 𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦_𝟑𝟑. 𝐱𝐱𝐱𝐱𝐱𝐱 from the ROSTER page. 

Run the estimation, and a new Estimation Results report should open after 57 iterations. 

Notice that adult detection and censoring parameters are still listed separately for the 

non-transported group and for each transport group, but the estimates are the same 

across all the groups now. The lambda estimates still differ for the non-transported 

group and the transport groups. 

Which of the three models considered is the best fit or most appropriate? These three 

models are nested, with Model 1.1 nested in Model 1.3, and both nested in Model 1.2. This 

means that we can use LRTs to compare these three models as described in Section 

4.2.1. In fact, this data set and models 1.1 and 1.2 are highlighted in the discussion of 

LRTs, where it was found that the added structure between the non-transported and 

transported groups was significant (𝑃𝑃 =  0.0003), and Model 1.2 was selected (Model 2 in 

Section 4.2.1) over Model 1.1. What about Model 1.3, where transportation effects are 

estimated only in the lambda parameters, with the detection and censoring parameters 

equated over juvenile migration method (inriver or transportation)? The function value for 

Model 1.3 is 𝐹𝐹𝐹𝐹3  =  478545.01244264 with 43 parameters, so the LRT test statistic for 

models 1.2 and 1.3 is 𝑋𝑋 =  14.82312 with 𝑑𝑑 =  4. The critical value for this test (at the 

95% significance level) is 𝜒𝜒4,0.95
2 = 9.4877. Because 𝑋𝑋 >  𝜒𝜒4,0.95

2 , we reject the null 

hypothesis of common detection and censoring parameters between non-transported and 

transported groups and conclude that Model 1.2 should be used. 

7.2 Example 2: 2002 Spring Chinook Salmon 

For this example, you can find the data set 𝐝𝐝𝐝𝐝𝐝𝐝𝐝𝐝𝐝𝐝. 𝐭𝐭𝐭𝐭𝐭𝐭 on the ROSTER page on the 

CBR website. 

https://cbr.washington.edu/analysis/apps/roster
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Records were available for 𝑁𝑁 = 303,096 spring Chinook salmon released in the Snake 

River upstream of Lower Granite Dam in 2002. Juvenile detections were available from 

Lower Granite (LGR), Little Goose (LGO), Lower Monumental (LMO), McNary (MCN), 

John Day (JD), and Bonneville (BON) dams. Adult detections were available in the years 

2003, 2004, and 2005 from the adult fish ladders at Bonneville, McNary, Ice Harbor, and 

Lower Granite dams. Fish were transported from LGR, LGO, LMO, and MCN. 

To load this data set into ROSTER, first set the data description settings to 6 

juvenile sites, 4 adult sites, and 3 adult age classes, and click the Load button on the 

program interface. Figure 7.6 shows part of the Data Summary report for this data set. 

Set the value in the Extent of Transportation Effects window to 7 and load the default 

model. 



67  

 

Figure 7.6. The top of the Data Summary report for the second sample data set. 

As with the first sample data, the default model for this data set (file 

𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦_𝟏𝟏. 𝐱𝐱𝐱𝐱𝐱𝐱 on the ROSTER webpage) equates detection and censoring parameters 

for each age class and detection site, regardless of juvenile migration method (i.e., 

transport versus non-transport). Because this data set has more than two adult detection 

sites, the default model in 𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦_𝟏𝟏. 𝐱𝐱𝐱𝐱𝐱𝐱 also equates adult survival parameters for 

each age class and site. Unlike the first data set, this data set includes transportation 

groups that were not detected as adults in certain age classes. In particular, no fish 
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transported from site 3 (LMO) was detected as an age-3 adult, and no fish transported 

from site 4 (MCN) was detected as either an age-1 or an age-3 adult. Thus, the default 

model fixes the corresponding age- and site-specific T/I parameters (i.e., 𝑅𝑅33, 𝑅𝑅41, and 

𝑅𝑅43) to 1; see Figure 7.7. 

 

Figure 7.7. The bottom part of the default model file (𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦_𝟏𝟏. 𝐱𝐱𝐱𝐱𝐱𝐱 ) for the second sample 

data set. 
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Now run the estimation routine by clicking Estimate Parameters on the 

Estimation tab (make sure the model is loaded first). The estimation routine stops after 

about 30 iterations, and the Estimation Results report opens. The report shows NA for 

the standard errors of the parameters that were fixed in the model file (e.g., all adult 

censoring parameters except for site 7, age class 2), indicating that these parameters 

were not estimated. Also, the report shows NA for the point estimates of parameters 

𝑅𝑅33 and 𝑅𝑅43, which is appropriate because these parameters were not estimated. 

However, the report also shows NA for the standard error of the survival probability 𝑠𝑠6, the 

detection probability 𝑝𝑝6, and other estimated parameters, and the survival parameter for 

site 9, age class 1 (i.e., 𝑠𝑠91𝐶𝐶) is estimated at 2.62247 with NA for the standard error, 

when its estimate should never be much greater than 1. These problems indicate that 

the estimation routine did not converge, even though it stopped and did not give a 

warning or error message. There is a problem with the model file. 

Examination of the Parameters report shows that several survival estimates were 

very high, including 𝑠𝑠5, 𝑠𝑠𝑠𝑠91, 𝑠𝑠𝑠𝑠93 and the associated survival parameters for 

transported fish. It is possible that because ROSTER had to estimate these values that 

are approximately 1, it could not also estimate certain other parameters. Accordingly, it is 

worth fixing these parameters to 1 (or 0.999999) and trying again to estimate the 

parameters. Figure 7.8 shows part of the edited model file with these survival 

parameters fixed; the edited model file, named 𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦_𝟐𝟐. 𝐱𝐱𝐱𝐱𝐱𝐱, is on the ROSTER 

webpage. Select this model definition file for use in the program interface and click the 

Estimate Parameters button. After 68 iterations, the optimization routine ends, and the 

revised Estimation Results report is available. Note that the parameters 𝑠𝑠5, 𝑠𝑠91, and 

𝑠𝑠93 all have point estimates equal to 1, with NA for standard error. The NA standard 

error indicates that these values were fixed to 1, rather than estimated at 1. This time, 

the estimates 𝑠𝑠6 =  0.95144 with 𝑆𝑆𝑆𝑆 =  0.06117, and 𝑝𝑝6 =  0.17882 with 𝑆𝑆𝑆𝑆 =

 0.01151, are given for 𝑠𝑠6 and 𝑝𝑝6, respectively (Figure 7.9). The user should explore 

whether the estimation can be performed by fixing some subset of the survival 

parameters 𝑠𝑠5, 𝑠𝑠91, and 𝑠𝑠93 to 1 (or 0.999999). 



70  

 

Figure 7.8. The bottom part of the edited model file for the second sample data set 

(𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦_𝟐𝟐. 𝐱𝐱𝐱𝐱𝐱𝐱), with survival parameters 𝑠𝑠5, 𝑠𝑠91, and 𝑠𝑠93 fixed to 1. 
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Figure 7.9. Part of the Estimation Results report for the second sample data set, using 

model 𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦_𝟐𝟐. 𝐱𝐱𝐱𝐱𝐱𝐱 (shown in Figure 7.8) on the ROSTER webpage. 

It is generally not necessary for the user to pick initial values (seeds) for ROSTER, 

because ROSTER calculates the MoM estimates to use as seeds. However, the user may 

select a different seed if desired and adjust the model file accordingly. The syntax for doing 

this is shown in Chapter 5. The complexity of the statistical model used by ROSTER 

means that the success of the estimation routine may be sensitive to using appropriate 

seeds. 
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The model fit for the second sample data set assumes that transportation effects 

end at the first adult detection site (i.e., Bonneville). We can explore whether the data 

indicate upriver adult effects of juvenile transportation by fitting models that estimate 

different adult survival, detection, and censoring parameters for transported versus non-

transported fish. On the Estimation tab of the user interface, select the default model 

and then change the extent of transportation effects to 10; load the model. Before running 

the estimation routine, save the model and examine it; this model is 𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦_𝟑𝟑. 𝐱𝐱𝐱𝐱𝐱𝐱 on the 

ROSTER webpage. Notice that in this model file, the adult parameters for the non-

transported group are equated, while the adult parameters for the four transport sites are 

equated separately. This model estimates unique adult survival, detection, and censoring 

parameters for transported versus non-transported fish all the way to the final detection 

site. 

Return to the Estimation tab and click Estimate Parameters. An error window 

pops up, announcing an estimation numerical error, and the Messages window also 

announces a numerical error. The model file will have to be edited. To determine how to 

edit the model file, first click the Load button to reload the default model and then 

examine the Parameters report. Again, we see that the seed for 𝑠𝑠5 is 1, while the seeds 

for the parameters 𝑠𝑠𝑠𝑠91, 𝑠𝑠𝑠𝑠93, 𝑠𝑠𝑠𝑠911, and 𝑠𝑠𝑠𝑠931 (and the parameters equated to them) 

are all at or above 1. We need to fix these parameters to 1 (or 0.9999999) in the model 

file. The file 𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦_𝟒𝟒. 𝐱𝐱𝐱𝐱𝐱𝐱 on the ROSTER webpage has the necessary modifications. 

Load that model and click Estimate Parameters again. This time, the estimation routine 

converges after 71 iterations. Upon examination, the Estimation Results report provides 

reasonable results (i.e., probability parameters are estimated between 0 and 1 with non-

NA standard errors of estimated parameters), so we conclude that the model 

converged. It may be wise to run the estimation routine again, after introducing random 

noise in the Parameter Seeds... option under the Diagnostics menu. Try entering a 

small amount of Proportional noise, say 0.01. You may receive an error message when 

running the estimation routine with noise in the seeds, due to the complexity of the 

model. If this happens, you will need to reload the model and click the Estimate 
Parameters button again. Eventually, you should find a set of random seeds that leads 

to convergence at the same function value as initially seen without noise. This is one 
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way to confirm that the estimation routine has found the correct MLE.  

We have fit two models for the second sample data set. Model 2.2 assumed 

transportation effects ended at the first adult site (Bonneville) and was fit with a function 

value of 𝐹𝐹𝐹𝐹2.2 =  823983.91550963 and 49 parameters. Model 2.4 estimated 

transportation effects to the final adult site (Lower Granite) and was fit with a function 

value of 𝐹𝐹𝐹𝐹2.4 =  823963.98198837 and 63 parameters. Model 2.2 is a simpler model than 

Model 2.4, and in the general case, the structure of Model 2.2 is nested in Model 2.4. 

However, the data set required fixing certain detection parameters to 0.999999 in the 

more complex Model 2.4, while they were left free in the simpler Model 2.2 (ROSTER fixed 

them automatically when the default model with extended transportation effects was 

loaded; see the file 𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦𝐦_𝟒𝟒. 𝐱𝐱𝐱𝐱𝐱𝐱). This means that even though Model 2.2 is a 

simpler model than Model 2.4, it is not actually nested in Model 2.4. Thus, we cannot 

compare the two models with a LRT but must instead use AIC. The AIC for Model 2.2 is 

𝐴𝐴𝐴𝐴𝐴𝐴2.2 =  1648066, and the AIC for Model 2.4 is 𝐴𝐴𝐴𝐴𝐴𝐴2.4 =  1648054, indicating that the 

greater flexibility in Model 2.4 enables a better fit to the data than Model 2.2. It may be 

useful to compare analogous survival parameters for transported and non-transported fish 

using z-tests; this requires finding the covariance between the two survival estimates from 

the Covariance Matrix report. It may also be useful to explore models with the extent of 

transportation effects set at either 8 or 9 to find the most parsimonious model.  
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